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1.1  Introduction

This document is designed to help you understand the Wind River ICE SX, the 
Wind River high performance emulation system. The Wind River On-Chip 
Debugging solution includes Wind River ICE SX and Wind River Workbench, a 
software tool for hardware and RTOS bring-up. Together, these products provide 
a fully integrated hardware and software solution that can be used for board 
bring-up, Flash programming, and production and testing. 

The Wind River ICE SX allows developers to perform source-level debug activities 
such as watching memory and controlling large numbers of registers. It allows 
users to shorten development cycles, even for extremely complex applications. 

This document outlines information that is specific to the Wind River ICE SX. It 
includes some information on performing functions with the ICE unit using 
Wind River Workbench. For detailed information about the debugger, please refer 



Wind River ICE SX for Wind River Workbench
Hardware Reference , 2.6.1  

2

to the Wind River Workbench User’s Guide and the Wind River Workbench for On-Chip 
Debugging User Tutorials.

1.2  System Overview

The Wind River ICE SX lets you control a target by utilizing the On-Chip 
Debugging (OCD) services embedded in the microprocessor of that target. It 
operates effectively as a standalone system, communicating with the OCD services 
resident in the microcode of the chip.

When accessed, the OCD services in the chip provide complete control of the 
microprocessor, and all interaction between the Wind River ICE SX and the target 
runs exclusively through the OCD connection. This means that the emulation 
system is effective for the entire development process, even before board-level 
peripherals are stable. 

The Wind River ICE SX includes full high-speed Ethernet support, as well as 
networking support for shared and remote debugging.
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1.3  Features

The Wind River ICE SX includes the following features:

Multi-Core Debugging

The Wind River ICE SX lets you debug multiple devices on a scan chain through 
the use of JTAG Server. Several commands have been implemented that let you 
initialize multiple processors and start and stop all devices simultaneously. 
Multiple debug sessions can be active at the same time.

Figure 1-1 Wind River ICE SX
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JTAG Server

The Wind River ICE SX JTAG Server provides the ability to control and 
manipulate multiple devices on a single scan chain ring. JTAG Server is a 
development tool that can access any device on the scan chain ring. 
Field-programmable gate arrays (FPGAs), electronically programmable logic 
devices (EPLDs), and other programmable devices can be loaded, eliminating the 
need for multiple device programmers and emulation hardware. 

High-Performance JTAG

The Wind River ICE SX eliminates slow download times and run control when 
developing with On-Chip Debugger (OCD) microprocessors. Performance is 
improved due to hardware logic that caches common JTAG scan chains. 

High-Speed Ethernet Connection

The Wind River ICE SX provides download speeds of up to 100KB per second, 
depending on the target. This is considerably faster than many other available 
products. 

On-Chip Debug Target Control

The Wind River ICE SX allows you to start and stop the target, set internal 
hardware and software breakpoints, take a target snapshot, reset the target, step 
one statement or instruction into function calls, and step over or out of a function. 

Built-In Hardware Diagnostics

The Wind River ICE SX includes a comprehensive suite of RAM tests, scope loops, 
and CRC tests.

Additional Custom Registers

The ICE unit supports 32 custom register groups, which results in a total of 960 
custom registers. 

Target Console Port

The Wind River ICE SX includes a target console port, which permits remote 
monitoring of applications and the serial port by channeling the serial port up 
through the network. 
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Remote Boot

In normal operation, the Wind River ICE SX boots from system files located in the 
flash filesystem. The ICE unit is also capable of booting from firmware using TFTP 
from a remote host. The only configuration required is the server IP address. This 
means that a group of developers could manage the Wind River ICE SX firmware 
from a single server, with everyone in this group booting remotely from this server. 
Configuration files can also be loaded remotely, allowing a group to manage all of 
its ICE files from a central location.

Static Boot

In this mode, a default target driver is loaded automatically when the 
Wind River ICE SX unit is booted. Multiple target drivers can also be 
automatically loaded at boot. The whole process is controlled by a bootapps.lst 
file, which is similar to an autoexec.bat file. This file can either be generated by the 
ICE unit, or edited on a host and copied into the flash filesystem. 

Dynamic Boot

This is the default mode for the ICE unit. Without the bootapps.1st file, no 
applications are loaded. Target drivers can be manually loaded using the Load 
command, or can be loaded using Wind River Workbench, which automatically 
loads the target driver required by the target specified in the Workbench Target 
Manager view. If a target driver is not found, the Wind River ICE SX searches for 
it on the default TFTP server, and boots remotely. 

Wind River ICE SX Firmware Update Emulation

For backward compatibility, you can send new firmware to the ICE unit using the 
Firmware Update Utility in Wind River Workbench. After the update, the ICE unit 
defaults to a static boot of the firmware that was just updated. 

1.4  Safety Information

You should observe some basic safety precautions when using the 
Wind River ICE SX. Following these precautions helps avoid injury and prevents 
damage to the ICE unit and any products connected to it. To avoid hazardous 
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conditions, use this product only as specified. For the purposes of this document, 
warning and caution symbols denote the following:

Precautions to Avoid Injury

Precautions to Avoid Property Damage

! WARNING:  Warning statements indicate conditions that could result in injury or 
loss of life and describe how to avoid them. 

! CAUTION:  Caution statements indicate conditions that could result in damage to 
this product or other property and describe how to avoid them.

! WARNING:  Do not operate in wet or damp environments or outside the 
recommended operating conditions. This product is intended for indoor use only.

Use only the power cord specified for this product, and use a properly grounded 
power outlet.

Do not operate this product in an explosive atmosphere.

Do not operate the product if it is damaged. Have a qualified service person 
inspect damaged equipment before use. 

! CAUTION:  Take precautions against electrostatic discharge, as it may damage some 
components.

Use care in handling, as delicate components can be easily damaged.

Provide proper ventilation to prevent the product from overheating.
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11.5  Layout Drawings

1.5.1  Personality Module Direct Connection 

Figure 1-2 Isometric View

Figure 1-3 Personality Module -- Front
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Figure 1-4 Personality Module -- Side

Figure 1-5 Personality Module -- Top
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11.5.2  Personality Module Connected with Extender Cable

Figure 1-6 Isometric View

Figure 1-7 Extender Cable -- Side
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Figure 1-8 Extender Cable -- Top
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2.1  Introduction

This chapter describes all of the hardware that is included with the 
Wind River ICE SX, and explains how to connect it to the target and host.

For the ICE unit to function correctly, there are three connection components you 
will need to address:

■ Connecting the Wind River ICE SX to a target

■ Connecting the Wind River ICE SX to a host

■ Applying power
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This chapter discusses each of these hardware components and provides some 
general information about the ICE hardware. 

2.2  Components Included with Wind River ICE SX

The following list describes all of the components included with the 
Wind River ICE SX shipment. If any components are missing from your shipment, 
please contact Wind River Customer Support.

■ ICE unit connected to an architecture-specific personality module

■ 1 Trigger IN/OUT cable

■ 1 OCD extender cable

■ 1 right-angle adapter

■ 2 RS-232 serial cables

■ 2 9-Pin RS-232 adapters

■ 2 25-Pin RS-232 adapters

■ 5-pin circular DIN power supply with grounding cable

In addition, your shipment may include adapters that you can use to modify the 
personality module so it can connect properly to the target. Inclusion of these 
adapters is dependent on your target architecture. 

2.3  Unpacking Information

Remove the Wind River ICE SX from its protective anti-static bag and place it on a 
desk or bench so that it is not covered. Remove any packing materials to ensure 
proper cooling. The ICE unit operates without requiring additional cooling.

! CAUTION:  Handle the ICE unit with caution and take measures to prevent 
electrostatic discharge.
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2.4  Wind River ICE SX Description

This section describes all the features that are physically located on the ICE unit. 
The descriptions are high-level, and is meant to be used strictly as a method of 
becoming familiar with the unit. 

2.4.1  Front Panel

Figure 2-1 shows a labeled diagram of the front panel of the ICE unit. Use this 
diagram to help locate the components that are described in this section.

51-Pin Cable

The Wind River ICE SX is shipped with a 51-Pin cable already attached to it. On 
one end, the cable connects to a 51-Pin control bus on the ICE. The other end of the 
cable terminates in a personality module, as shown in Figure 2-2.

Figure 2-1 Front Panel of Wind River ICE SX

51-pin cable Trigger port

TGTCONS port

LEDs
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This personality module is specific to the architecture of the target board to which 
you are connecting the Wind River ICE SX. You can change the personality 
module, if necessary, by removing it from the connector at the end of the 51-Pin 
cable and replacing it with a different personality module. For instructions on how 
to change a personality module, see 2.8 Changing the Personality Module, p.33.

Wind River ICE SX LEDs

There are five LEDs located on the front panel of the Wind River ICE SX unit, as 
shown in Figure 2-1. Table 2-1 describes the function of each of these LEDs. 

Figure 2-2 Personality Module

Table 2-1 LED Descriptions

LED Description

Run When illuminated, this LED indicates the processor on the target board 
is in normal execution mode, which is typically the case when code is 
running on the target.
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Target Console Port

The Target Console Port, labeled TGTCONS on the front of the ICE unit, is an 
optional connection only. Use this port to provide serial communication over a 
network when the Wind River ICE SX is not directly connected to your host. 

Trigger In/Out

The Trigger In/Out port on the front of the Wind River ICE SX unit is a three pin 
connector. Wind River provides a Trigger In/Out cable that attaches to this 
connector on one end and has three flying leads on the other. Use the ground pin 
of this connector to ground the ICE unit and your target. Information about 
grounding a target is available in 2.7.1 Grounding the Target, p.23. The Trigger In 
and Trigger Out pins provide input and output interfaces for external hardware. 

Debug When this LED is lit, background mode communications have been 
established with the target microprocessor through the standard reset 
sequence. In this state, the Wind River ICE SX is ready to begin working 
with the target. If the LED is flashing, the ICE is in error mode. You will 
need to rectify this problem before the ICE unit can begin working with 
the target.

Tx When this LED is lit, the Wind River ICE SX is transmitting data to the 
host computer.

Rx When this LED is lit, the Wind River ICE SX is receiving data from the 
host computer.

Power When illuminated, this LED indicates that the power supply is connected 
to the ICE unit and the power switch is in the ON position. If the LED is 
green, it indicates that ICE is in normal operation mode, and if it is 
amber, it indicates that it is in Reset mode. Reset mode simply means that 
the ICE unit is going through its initialization sequence.

Table 2-1 LED Descriptions

LED Description
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2.4.2  Back Panel

Figure 2-3 shows the back panel of the ICE unit. Use this diagram to locate the 
components that are described in this section.

RS-232 Serial Port

This is a standard RS-232 port that is used to establish a serial channel between the 
Wind River ICE SX and the host computer. This connection is required to configure 
the ICE for network operation. For information on making the physical connection 
between Wind River ICE SX and the host, please refer to 2.6 Connecting 
Wind River ICE SX to a Host, p.19. For information on configuring ICE for network 
operation, please refer to 3. Configuring Wind River ICE SX for Network Operation. 

Power/Hardware Reset Switch

This is a three position rocker switch that turns power on to the ICE unit. When the 
switch is all the way in the downward position, the power is off. When the switch 
is in the middle position, the power is on. The top most switch position is on a 
spring so that the switch can only be clicked to that position for a moment. Clicking 
the switch once in the upper position performs a hard reset of the ICE unit. 

Ethernet Ports

There are two Ethernet ports on the back panel of the Wind River ICE SX. One port 
is 10BaseT only; the second port automatically detects the port speed and uses 

Figure 2-3 Back Panel

Ethernet ports

LEDs LEDs

DC power 
input

RS-232
serial port

Power/Hardware Reset switch
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either 10BaseT or 100BaseT, depending on network speed. Use either of these ports 
to connect the Wind River ICE SX to the network. 

LEDs

The back panel of the Wind River ICE SX unit includes six LEDs, aligned vertically 
in two rows of three, one on either side of the two Ethernet ports. The three beside 
the 10BaseT port describe activity that is occurring on that port, and the three 
beside the 10/100BaseT port describe activity that is occurring on that port. Both 
groups of LEDs perform identical functions; which ones are lit depends on which 
Ethernet port is being used. Table 2-2 describes the functions of these LEDs.

DC Power Input

This is the connector for the power supply. Information on connecting power can 
be found in 2.7 Applying Power, p.23.

2.5  Layout Drawings

Figure 2-4 shows the dimensions for the Wind River ICE SX unit. All dimensions 
are in inches unless otherwise noted.

Table 2-2 Back Panel LEDs

LED Description

Link This LED indicates that a physical connection to a network has been 
made.

TX This LED indicates that information is being transferred from the 
Wind River ICE SX back to the network.

RX This LED indicates that information is being received by the ICE unit 
from the network.



Wind River ICE SX for Wind River Workbench
Hardware Reference , 2.6.1  

18

Figure 2-4 Layout Drawings
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2.6  Connecting Wind River ICE SX to a Host

You must properly connect the ICE unit to a host computer for it to function 
correctly. You will need to make both a serial connection and an Ethernet 
connection if the ICE unit is going to be used on a network. You should make the 
serial connection first, since this connection is used to set up the network 
connections. Once you have set up networking for your Wind River ICE SX, the 
serial connection is no longer necessary. Please see 3. Configuring 
Wind River ICE SX for Network Operation for more information.

Make all the host connections from the back of the ICE unit. Figure 2-3 shows the 
back of the unit.

2.6.1  Serial Connections

To set up a serial connection:

1. Connect the RS-232 serial cable that was shipped with your unit to the RS-232 
serial port on the back of the ICE unit.

2. Connect the serial cable to either the 9-Pin or 25-Pin RS-232 adapters included 
with the shipment. Use the adapter that correctly mates with the COM port 
you want to use on your PC.

3. Connect the serial cable to the host computer’s COM port using either the 
9-pin or 25-pin adapters. Figure 2-5, Figure 2-6, and Figure 2-7 show the pins 
that are actually used for the RS-232 Port on the Wind River ICE SX rear panel, 
the 25-pin adapter, and the 9-pin adapter.

NOTE:  Use the serial connection to set up network communications for the ICE. 
This connection cannot be used for debugging.

NOTE:  This is not the TGTCONS port located on the front of the 
Wind River ICE SX unit. The correct serial port to use is located on the back of the 
ICE.
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Figure 2-5 RS-232 Port (Rear Panel)

Table 2-3 RS-232 Pin Scheme

Pin # Host Target (ICE)

Pin 2 Transmit Receive

Pin 3 Receive Transmit

Pin 5 Ground Ground
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Figure 2-6 25-Pin Female Adapter

Table 2-4 25-Pin Female Adapter Pin Scheme

Pin # Host Target (ICE)

Pin 2 Transmit Receive

Pin 3 Receive Transmit

Pin 7 Ground Ground

Figure 2-7 9-Pin Female Adapter

Table 2-5 9-Pin Female Adapter Pin Scheme

Pin # Host Target (ICE)

Pin 3 Transmit Receive

Pin 2 Receive Transmit

Pin 5 Ground Ground
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2.6.2  Ethernet Connections

Connect the Ethernet cable to the Ethernet port you want to use on the back of the 
ICE unit. The emulator has both a 10BaseT-only Ethernet port and a second port 
that automatically detects the port speed and then uses either 10BaseT or 100BaseT, 
depending on the network speed. Either port can be used to connect.

Connect the other end of the Ethernet cable to the network device.

NOTE:  At this stage, you are making a physical connection between the ICE unit 
and the network. For this connection to be functional, the ICE must be correctly 
configured for network operation using the serial connection. Please refer to 
3. Configuring Wind River ICE SX for Network Operation for more information. 

Figure 2-8 Wind River ICE SX Ethernet Ports

Ethernet ports

NOTE:  To connect directly to your PC network card, you need to use a cross-over 
cable. To connect directly to a network device, such as a hub, a regular Ethernet 
cable can be used.

NOTE:  If no Ethernet cable is connected when the power switch on the ICE unit is 
turned on, it defaults to 10BaseT operation. To use the 100BaseT connection, you 
must perform a power-up sequence by rocking the RESET switch on the back of the 
ICE. In addition, if you switch from 10BaseT to 100BaseT while the unit is on, you 
must power cycle the ICE before you can use the 100BaseT connection.
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2.7  Applying Power

To power the Wind River ICE SX and your target, complete the following steps. 

1. Ground ICE and your target.

2. Connect ICE to your target.

3. Connect the ICE power supply to your ICE unit and turn it on.

4. Connect your target power supply to your target board and turn it on. 

2.7.1  Grounding the Target

When connecting the ICE to a target board, damage can occur if the two devices 
are not at similar voltage potentials. These potential differences occur when the AC 
and DC grounds on the target do not have a common reference. Following the 
steps in this section references all of the DC logic grounds to the AC grounds 
gracefully, and prevents damage to either the ICE unit or the target board. 

1. Ensure that the ON/OFF/RESET switch on the back of the ICE unit is in the 
OFF position.

2. Connect the supplied Trigger In/Out cable to the Trigger port on the front of 
the ICE unit. The cable has a three-pin female connector on one end and three 
flying leads on the other. Two of the three leads have white sleeves at the end 
and are labeled TRIG IN and TRIG OUT respectively. The third lead has a 
black sleeve and is labeled GND. 

3. Connect the male pin of the supplied ground cable to the ground wire of the 
trigger cable. This is the flying lead with the black sleeve labeled GND. 

4. Connect the female contact of the ground cable to the target. You may use the 
supplied test clip to simplify this process.

! CAUTION:  Proper grounding may be necessary to prevent damage to the 
Wind River ICE SX and the target board.

NOTE:  The power switch on the ICE unit should remain in the OFF position 
until all target connections have been made. Following the sequence of the 
sections in this chapter ensures that all the connections are made and power is 
applied in the correct order.
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Leave the ground clip in place until all of the connections have been made between 
the Wind River ICE SX and the target, and power has been applied to both devices. 
Keep in mind that if you disconnect the ICE from the target, you must repeat this 
process the next time it is connected. 

2.7.2  Connecting Wind River ICE SX to a Target

Once you have connected the Wind River ICE SX to the host, and equalized the 
ground potential between the ICE and the target, you can connect the ICE to the 
target. 

The ICE connects to the target via a 51-pin cable that is pre-attached to the unit at 
the factory. At the end of this cable is a personality module that mates with the 
OCD port on the target.

All target-side connections attach to the front of the ICE unit. Figure 2-10 shows the 
general connection scheme of the unit.

Figure 2-9 Wind River ICE SX Ground Connection
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Connecting the Personality Module to the OCD Port

Connect the personality module to the target’s OCD port. Pin 1 of the personality 
module is labeled on its underside to help ensure that it is properly aligned with 
Pin 1 of the OCD port.

Figure 2-10 Connection Scheme

! WARNING:  Make sure that Pin 1 of the ICE personality module is connected to Pin 
1 of the OCD port on the target board. Plugging this device in backwards could 
result in permanent damage to the target.
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The OCD connector on the target is dependent on the processor family, and for this 
reason the personality module on the Wind River ICE SX is specific to the 
processor family being used. In some cases, an adapter may be shipped with ICE 
that makes connecting to the target easier. 

Target Connection Options: Right Angle Connector and OCD Extender Cable

For the highest possible performance, Wind River recommends that you make a 
direct connection between the ICE personality module and the OCD port on the 
target board. If it is not possible to make a direct connection due to target system 
setup, you can use the supplied right angle connector or the OCD extender cable. 

The right angle connector is designed for cases where a more vertical connection 
scheme is required than the personality module connection allows for. To use the 
right angle connector, identifiable in the shipment as a 0.1” on-center socket with 
gold plated 0.025” square metal pins at a right angle, connect the right angle 
connector’s male pins to the personality module. Then connect it to the OCD port 
on the board—the female sockets on the connector mate with the OCD 
development port header. Be sure to verify proper pin 1 alignment between the 
personality module and the development port header. 

If making a direct connection or using the right angle connector is impossible, the 
OCD cable can be used as a bridge between the personality module and the OCD 
development port. To use the OCD extender cable, connect the OCD cable’s male 
header to the female header of the personality module. Then connect the cable’s 
female header with the OCD development port on the board, as shown in 
Figure 2-12.

Figure 2-11 Connecting the Personality Module
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Serial (RS-232) Target Connections

In situations where the ICE is not connected directly to your host computer during 
configuration, a serial channel can be opened with the target using the TGTCONS 
port on the front of the ICE unit. 

To use this function, you must configure the Wind River ICE SX for network 
operation. Please refer to 3. Configuring Wind River ICE SX for Network Operation 
for more information.

The purpose of this section is to describe how to make the physical connections 
between the TGTCONS port on the ICE unit and the target. The following steps 
explain how to use this function.

1. Connect one end of one of the RS-232 cables into the TGTCONS port on the 
front of the ICE unit.

2. Connect the other end of the cable into either the 9- or 25-pin female D 
subminiature adapter. 

3. Take the second RS-232 cable included with the shipment and plug it into the 
serial port on the target. 

Figure 2-12 Wind River ICE SX Connected To The Target Via OCD Extender Cable

NOTE:  This extender cable affects the signal quality of the debug interface. When 
using this cable you must operate the debug interface at lower frequencies to avoid 
intermittent operation. If you encounter mechanical difficulties when connecting 
to the target, first try using the right angle adapter provided.
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4. Connect the other end of the cable that is connected to the target to either the 
9- or 25-pin male D subminiature adapter. Make sure that you choose the same 
type of adapter (either 9 or 25 pins) as was used in Step 2. 

5. Connect the two 9- or 25-pin D subminiature adapters together to complete the 
connection between the target and the ICE unit. 

The following figures show the pins that are actually used in the TGTCONS port, 
the 25-pin adapter, and the 9-pin adapter.

Figure 2-13 TGTCONS Port

Table 2-6 TGTCONS Port Pin Scheme

Pin # Host (ICE) Target

Pin 3 Transmit Receive

Pin 2 Receive Transmit

Pin 5 Ground Ground
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Figure 2-14 25-Pin Male Adapter

Table 2-7 25-Pin Male Adapter Pin Scheme

Pin # Host (ICE) Target

Pin 2 Transmit Receive

Pin 3 Receive Transmit

Pin 7 Ground Ground

Figure 2-15 9-Pin Male Adapter

Table 2-8 9-Pin Male Adapter Pin Scheme

Pin # Host (ICE) Target

Pin 3 Transmit Receive

Pin 2 Receive Transmit

Pin 5 Ground Ground
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2.7.3  Connecting Power 

Before applying power, ensure that the Wind River ICE SX has been properly 
connected to the host and the target, and that steps have been taken to ensure 
proper grounding. 

The Wind River ICE SX includes a power supply that converts standard 110 -240 
VAC 50/60Hz to 5V DC at 6A. The DC input connection is located on the back 
panel of the ICE unit. The power supply is fused with a 5mm x 20mm, 2A, 250V 
fuse

See Table 2-9 for Wind River-specified part numbers.

The ICE power connection is a standard 5-pin circular DIN connection with a 
locking mechanism. Slide back the sleeve on the 5-pin connector as shown in 
Figure 2-16.

! WARNING:  The power supply contains no user serviceable parts and should not be 
disassembled. To avoid electrical shock and possible loss of life, do not 
disassemble the power supply.

Table 2-9 Wind River ICE SX Part Numbers

Wind River Part Number Description

PWR-R00010-001 Power Supply

CAB-R00003 Power Cord, United States

CAB-R00004 Power Cord, European

CAB-R00005 Power Cord, United Kingdom

CAB-R00018 Power Cord, Israel
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With the sleeve slid back, plug the supply into the DC input connector on the back 
of the ICE unit. Release the sleeve, locking the power supply into place, as shown 
in Figure 2-17.

Figure 2-16 Power Supply Locking Mechanism
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Power the ICE unit by moving the power switch on the back of the unit to the ON 
position—the middle position on the three-position rocker switch. The Power LED 
on the front of the ICE unit illuminates, turning amber for a few seconds while it 
goes through its power-up sequence, and then green, indicating that it is ready. The 
illumination of this LED indicates that power has been successfully applied to the 
unit.

To use the Wind River ICE SX with a target board, you will also need to apply 
power to the target board being used. For information on applying power to the 
target, see the documentation included with your target. 

Figure 2-17 Wind River ICE SX With Power Supply
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2.8  Changing the Personality Module

To change the target architecture the Wind River ICE SX communicates with, there 
are a number of steps that you must take. This section describes how to replace the 
personality module. 

To change the personality module and replace it with another:

1. Remove the personality module using a small screwdriver to unlatch the 
module. 

On the underside of the target end of the 51-pin cable, you will see a small 
rectangular cover that clips the module into place. 

Pry the module out of its position by gently pushing the screwdriver into the 
open grooves located on the sides of the cover, as shown in Figure 2-18.

The personality module is released. 

! CAUTION:  Before attempting to change the personality module on the ICE unit, 
make sure that the power on the Wind River ICE SX is OFF, and that it is 
disconnected from the power supply. In addition, please disconnect your ICE unit 
from your target board.

Figure 2-18 Using a Screwdriver to Remove the Personality Module
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2. To attach a new personality module, align the front edge of the module’s 
rectangular cover with the front edge of the target end of the 51-pin cable. 

The glossy teal label on the personality module should be facing away from 
you. 

When the front edges are aligned, as shown in Figure 2-19, the grooves on both 
the rectangular cover and the 51-pin cable are also aligned.

3. Press both thumbs on each side of the cover, and snap the personality module 
into place. 

When inserting, it is helpful to press down on both sides of the cover with 
equal force. When the module is properly inserted, it snaps into place and is 
solidly attached to the cable.

After you have successfully changed your personality module, return to 
2.7 Applying Power, p.23, for information about making the physical connections 
between Wind River ICE SX and your target board.

Figure 2-19 Aligning the Personality Module
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3.1  Introduction

The Wind River ICE SX provides full Ethernet support and is designed to operate 
on any TCP/IP network. The following list describes some of the advantages to 
using an ICE on a network. 

Remote Access to Wind River ICE SX

When properly connected to a network via the Ethernet port, the ICE becomes a 
separate functional component on that network. It can be accessed by any PC or 
workstation that is included on the LAN, thus allowing for remote operation. 



Wind River ICE SX for Wind River Workbench
Hardware Reference , 2.6.1  

36

High Speed Communication

The Ethernet channel used to connect Wind River ICE SX to the host PC or 
workstation has a much higher bandwidth than any other communications 
medium supported by the ICE. The result is that download and debugging times 
are significantly faster.

3.2  I/O Ports on Wind River ICE SX

The ICE has several ports that you can use to communicate with a host computer 
or a network. Their use is described in 3.5 Configuring Wind River ICE SX for 
Network Operation, p.47.

RS-232 Port (Back of ICE Unit)

This port lets you make a direct serial connection between the Wind River ICE SX 
and a host computer. Over this connection, you configure the Wind River ICE SX 
for networking and are able to issue low-level emulator commands, including 
many network commands.

Ethernet Ports

Two Ethernet ports are available on the back of the ICE unit, labelled 10BaseT and 
10/100BaseT respectively. Either of these ports can be used to make Ethernet 
connections. 

The three ports are shown in Figure 3-1.

Figure 3-1 Rear View of Wind River ICE
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3.3  Networking Overview

For the Wind River ICE SX to function correctly on your network, you must 
program the non-volatile memory (NVRAM) in the ICE unit with specific network 
information to make it visible on your network. 

This section explains some of the networking concepts you need to understand to 
decide how you want to configure the ICE unit. In addition to IP addressing, this 
section describes netmasks, routing, default routing, and several of the 
Wind River ICE SX protocols.

If you are already familiar with these concepts, you may skip to 3.5 Configuring 
Wind River ICE SX for Network Operation, p.47. 

3.4  IP Addressing

An IP address is an identification number used by network software to locate a 
device on that network. The network uses the IP address to direct data to a specific 
device. IP addresses differ from Media Access Controller (MAC, or Ethernet) 
addresses in that IP addresses are specific to the protocol being used, TCP/IP in 
this case. Also, MAC addresses contain no information about where a network 
device is located, whereas IP addresses do.

The IP address is assigned locally, and must be unique to a particular network. 
They are 32-bit numbers, usually written as four sets of numbers separated by 
periods, such as 255.255.255.255.

The Wind River ICE SX can determine its IP address in one of four ways:

■ Dynamic Host Configuration Protocol (DHCP)
■ Manual programming
■ Reverse Address Resolution Protocol (RARP)
■ Bootstrap Protocol (BOOTP)

Programming the IP address manually means you enter and store the IP address 
in the ICE unit’s NVRAM. 

Some network administrators use a central database to maintain the IP addresses 
of all of the nodes on their network. In this case, when a network node boots up, it 
queries the database via the network to determine its IP address. The 
Wind River ICE SX supports the DHCP, RARP, and BOOTP protocols, but you 



Wind River ICE SX for Wind River Workbench
Hardware Reference , 2.6.1  

38

must program it to use the proper protocol. This protocol programming is only 
necessary once, and it is stored in the ICE unit’s NVRAM. 

The following sections explain how each of the methods work. 

Dynamic Host Configuration Protocol

The Dynamic Host Configuration Protocol (DHCP) is the simplest method of 
assigning an IP address to the ICE unit. The only requirement is that the network 
that you are working on must have a DHCP server. 

Using the DHCP protocol, when a client device on the network is booted, it 
broadcasts a request for address information. The DHCP server takes that request 
and assigns a new address for a specified time period (usually a number of days, 
depending on how the network administrator has it configured) and sends this 
address to the client along with any other required configuration information. The 
additional information might include gateway, netmasks, or any required routing 
information, depending on how the network is set up. This packet of information 
is acknowledged by the client and used to set up its configuration. 

While an IP address is leased to a client, it will not be reallocated by the DHCP 
server. In addition, every time a client requests an IP address, the DHCP server 
attempts to assign it the same address every time. The client can extend its lease 
with additional requests. It can also send a message to the DHCP server before the 
lease expires telling it that it no longer needs an address and releasing it. 

Manual Programming

Manually assigning an IP address to the Wind River ICE SX is a very simple 
process, although the risk of user error is higher than with automated processes. In 
this case, you enter the IP address and other potentially required information 
manually over a serial connection to the ICE. The information is stored in the unit’s 
non-volatile memory (NVRAM), so reprogramming this information is not 
necessary unless your network configuration changes (for example, if your 
network administrator reconfigures your network.)

Reverse Address Resolution Protocol

With the Reverse Address Resolution Protocol (RARP), when a device on the 
network is booted, it broadcasts a packet containing its MAC (Ethernet) address to 
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all other nodes on the network and requests address information. The RARP server 
responds with a correct address packet, which is received by the client. The client, 
in this case the Wind River ICE SX, extracts the IP address information from the 
address packet. 

With RARP, the Wind River ICE SX can only extract the IP address from the 
address packet that is sent by the server. Any additional required information, 
such as gateways or netmasks, must still be entered manually. 

The IP address sent by the RARP server may be a static IP address for the ICE unit, 
or it may be one that is sent from a pool of addresses that your network 
administrator has set up to be available for users. If this is the case, a new IP 
address may be assigned to your ICE unit every time you boot the unit. Regardless 
of which method your network administrator has set the RARP server to use, it is 
transparent to the ICE user. 

Bootstrap Protocol (BOOTP)

The Bootstrap protocol (BOOTP) functions very similarly to RARP. However, it is 
capable of transmitting more than just the IP address to the networked device. 
With BOOTP, the basic operation is the same, in that a packet containing the 
device’s MAC (Ethernet) address is broadcast by the network device that is 
booting to all other nodes on the network. The BOOTP server receives this request 
and responds with a packet of address information. The device on the network 
receives this packet and extracts the necessary information from it, including the 
IP address.

The main advantage that BOOTP has over RARP is that it can provide more than 
just the IP address to the Wind River ICE SX. Information about the gateways and 
netmasks that are set up on the network can also be passed to the ICE unit, 
eliminating the need for users to manually enter this information.

In addition, BOOTP uses a higher layer protocol which can be passed through 
routers. Figure 3-2 shows how BOOTP and RARP work.
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RARP

In this example, when Node 1 on the network is booted, it sends a RARP request 
containing its MAC (Ethernet) address. Node 2 on the network contains a database 
which maps MAC addresses to IP addresses, and is therefore able to respond to 
Node 1’s request for IP information. Note that in this case the RARP request does 
not pass through the router.

BOOTP

In this case, when Node 1 on the network is booted, it sends a BOOTP request 
containing its MAC address. In this case, the request goes to Node 2, and also 
passes through the router and goes to Node 3. Both Node 2 and Node 3 respond to 
this request. Since Node 2 contains the database that maps MAC addresses to IP 
addresses, it responds to Node 1 with the correct address packet. Node 3 issues a 
response to Node 1 saying that it cannot provide the requested information.

3.4.1  Netmasks and Routing

TCP/IP networks can be subdivided into multiple logical networks using routers. 
Netmasks are used to identify which of the physical networks a network node 
resides on. A netmask is a 32-bit number that is used to separate an IP address into 
two logical parts—a network address and a host address. The router uses a 
netmask to determine which physical network a host resides on. In larger network 
environments where routers are used, it may be necessary to program a netmask 
and set up a routing method on the Wind River ICE SX. This is only necessary if 
you want to access the ICE from a host computer that is on a different network than 
the ICE unit resides on, and the two networks are separated by a router. For 

Figure 3-2 RARP and BOOTP Network Transactions
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example, this may be the case if the ICE is set up in a laboratory and you want to 
try to access it from your office.

Bridges are not the same as routers, and they require no special configuration on 
the ICE unit.

If the environment requires that your Wind River ICE SX be separated from the 
host computer by a router, then the ICE has to be configured to anticipate the 
router. This can be done in one of two ways:

■ Programming a routing table into the ICE unit’s NVRAM.

■ Configuring the ICE to dynamically determine its routing table using a 
Routing Information Protocol (RIP).

Separating an IP Address into Host and Network Parts

An IP address can be separated into its host and network parts by performing a 
logical AND of the IP address with the netmask.

For example, if the IP address is 192.9.200.02 (0xC009C802) and the netmask is 
255.255.0.0 (0xFFFF0000), then performing a logical AND of the two addresses 
shows that the network portion of the IP address is 192.9.0.0. That means that on 
that network (the 192.9.0.0 network), the host is located at 0.0.200.02. 

When the Wind River ICE SX sends a packet, it performs this calculation to 
determine if the address the packet is being sent to is on the same network as the 
ICE. If it is not on the same network, the ICE knows that it needs to consult its 
routing table to determine the IP address of a router that can forward the packet to 
the correct network. 

Sending a Packet on the Same Network

If the IP address of the ICE unit is 192.9.200.02 and it wants to send a packet to 
192.9.200.230, and the netmask is 255.255.0.0, then the calculation reveals that both 
addresses are on the 192.9.0.0 network. Consequently, there is no need to send the 
request through a router and the packet can be sent directly.

Sending a Packet on Different Networks

If the IP address of the ICE unit is 192.9.200.02 and it wants to send a packet to 
192.10.201.3, and the netmask is 255.255.0.0, then the calculation reveals that the 
ICE unit is on a different network than the intended recipient of the packet. The 
Wind River ICE SX consults its routing tables to determine which IP address is 
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needed to find a router that can reach the 192.10.0.0 network that the intended 
recipient is located on. 

Routing Tables

Routing tables are arranged as pairs of network addresses and IP addresses. The 
ICE releases a packet that has a network address of X. If the ICE is not on network 
X, it consults its routing tables, which takes the packet and readdresses it to Y. Y is 
a packet that includes all of the information from X but is addressed to a router on 
the network that the ICE is on. The router takes the information from packet Y and 
checks to see if it is on a network that is directly connected to it. If it is not, it sends 
it on to another router, which repeats the process. The packet continues to be sent 
from router to router until one of the routers discovers that the original packet X is 
addressed to a segment that is directly connected to it. This process can usually be 
completed in a few hops between routers unless some kind of Wide Area Network 
(WAN) lies between the Wind River ICE SX and the desired recipient.

The concept of routing and routing tables can be explained using the following 
example. Figure 3-3 shows a sample network containing four network nodes (the 
Wind River ICE SX and three hosts) and two routers.

Figure 3-3 Sample Network
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The sample network consists of four separate networks that are connected by 
routers, and the netmask is 255.255.0.0 (0xFFFF0000). The ICE must be set up with 
a routing table that allows it to communicate with any of the three hosts. Since the 
ICE does not require a router to communicate with a device on the 192.9.0.0 
network, because it is located on that network, three address pairs must be 
included in the routing table to account for the three other networks. The routing 
table for this network is shown in Table 3-1.

As shown in the table, the Wind River ICE SX only needs to know the IP address 
of one router to deliver a packet anywhere on the network. This is because ICE is 
only responsible for getting the packet to the next IP address. 

If you want the ICE to send a packet to Host 3, it first checks to see whether Host 
3 resides on the 192.9.0.0 network. Since it does not, the ICE consults the routing 
table and determines that to send to an IP address on the 192.10.0.0 network, it 
must address the packet to the 192.9.200.1 router. The router at that address 
receives the packet, determines that Host 3 is directly connected to it, and sends it 
to Host 3.

If you want the ICE to send a packet to Host 2, it first checks to see whether Host 
2 resides on the 192.9.0.0 network. Since it does not, the ICE consults the routing 
table and determines that to send to an IP address on the 192.20.0.0 network, it 
needs to address the packet to the 192.9.200.1 router. The router at that address 
receives the packet and determines that the 192.20.0.0 network is not directly 
connected to it, so it forwards the packet on to the second router. The second router 
receives it, determines that Host 2 is directly connected to it, and forwards the 
packet to Host 2. 

How Wind River ICE SX Determines Routing Tables

There are two ways that the ICE can determine its routing tables. The first is to 
program the routes directly into the ICE unit’s NVRAM. Using this method, there 
is enough storage provided for up to ten routes to be stored. With this method, the 

Table 3-1 Sample Routing Table

To get to an IP address on this network Send to the router at this IP address

192.10.0.0 192.9.200.1

192.15.0.0 192.9.200.1

192.20.0.0 192.9.200.1
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information must be changed any time the routing information changes on the 
network.

The Wind River ICE SX is also capable of dynamically determining its routing 
tables. This is done by enabling the dynamic routing option and storing it in the 
ICE unit’s NVRAM. In this mode, ICE sends out a special packet called a RIP 
request when it boots up. When a router receives this request, it sends the routing 
table information back to the Wind River ICE SX. As routing information changes, 
the routers broadcasts this information to any devices on the appropriate logical 
networks. ICE captures these packets and update the routing tables as needed. 
Dynamic routing is typically used on networks with a large number of routers. 

Default Route

In situations where Wind River ICE SX would only have to send to one router to 
find any other node on the network, as was the case in the routing tables example, 
a shortcut is available. The default route is the address of the router that is used 
when all other routing attempts do not show a clear path to the destination 
network. Using this method, if ICE cannot determine a router to send a packet to, 
it sends it to the default router on the assumption that the router is able to find the 
destination network. In the example shown previously, the default route could be 
set at 192.9.200.1 and the routing table left blank. In that case, if ICE cannot find an 
address it sends the packet to 192.9.200.1 on the assumption that the router can find 
the correct destination address.

3.4.2  Servers, Protocols, and Service Ports

Almost all network products use a client-server architecture. A client performs the 
actions of getting user input, transporting the input to a server, and awaiting a 
response from the server. A server waits for the client input, carries out necessary 
actions based on the input, and returns a response to the client. Wind River ICE SX 
is based on a scalable client-server architecture and a number of network servers 
are provided within the ICE unit. The servers carry out the actions of various client 
programs which run on host computers, either PCs or workstations. The most 
common client program is a source level debugger.

All network servers must have a way of identifying themselves, and this is 
typically accomplished through the use of service ports. On a TCP/IP network, a 
service port is a 16-bit number that is encapsulated in each packet so that the 
receiver can determine which program, client or server the packet should be 
delivered to. Each server is identified by three items:
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■ the IP address of the node it runs on

■ the type of protocol it uses

■ the service port within the protocol it uses

Wind River ICE SX implements several servers. Some are based on connection 
oriented protocols called STREAMS. Others are based on connection-less protocols 
called DATAGRAMS. Many of the servers use well known protocols and ports, 
such as Telnet, while others use ports that are specific to the manufacturer of a 
product, such as a source-level debugger. 

The following table describes the server, protocol type and port numbers used by 
various servers on ICE.

Since Wind River ICE SX can be used for multi-core debugging, an additional set 
of servers are launched for every set of application firmware that is in use. The 
following table describes the servers, protocols, and ports that are assigned for 
each additional set of firmware that is launched.

■ The # values for each of the servers listed in Table 3-3 start with #=0 and 
increase sequentially for each set of application firmware that is loaded. 

■ The m values for each of the port numbers listed in Table 3-3 start with m=2 
and increase sequentially when the n value rolls over 9. 

Table 3-2 Servers, Protocols, and Ports used by Wind River ICE SX

Server Protocol Port Description

Telnet Port STREAM 23 Standard TCP/IP Telnet Server capabilities

TGTCONS Port STREAM 1232 Target Console port

SHELLD STREAM 1233  Control Port

Table 3-3 Servers, Protocols, and Ports for Each Set of Firmware

Server Protocol Port Description

ESTD# STREAM 1mn4 STREAM based debugger

TCPD# STREAM 1mn5 STREAM based debugger, or OCD API 3.x

LOADD# STREAM 1mn6 Target console port

WRS# STREAM 1mn7 Wind River specific tools
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■ The n values for each of the port numbers listed in Table 3-3 start with n=3 and 
increase sequentially for each set of application firmware that is loaded. 

For example, the first application firmware that is loaded would have the ESTD0 
server on port 1234, and the second set of firmware that is loaded would have the 
ESTD1 server on port 1244. 

You can view the various processes and their associated port numbers by issuing 
a PS (Process Status) command from a >NET> prompt in the Terminal view.

The following shows the result of a PS command when you have made a serial 
connection to the Wind River ICE SX but have not yet connected to a target:

>NET>ps

NAME TSK_ID TYPE PRIORITY STATE
----------------------------------------------------------------------------

TGTCONS *00000025 PrmServ 00000190 ConnWait 0.0.0.0 (1232)
SHELLD *00000026 PrmProc 00000065 ConnWait 0.0.0.0 (1233)

* = Tapable with comtap

>NET>

The following shows the result of a PS command after connecting the ICE to a 
PPC750FX target:

>NET>ps

NAME TSK_ID TYPE PRIORITY STATE
--------------------------------------------------------------------------
TGTCONS *00000025 PrmServ 00000190 ConnWait 0.0.0.0 (1232)
SHELLD *00000026 PrmProc 00000065 ConnWait 0.0.0.0 (1233)
PPC6XX 00000106 00000180 running 
UJD 00000123 PrmServ 00000210 running 
ESTD0 *00000128 PrmServ 00000200 Connected to 255.0.11.4 (1271)
TCPD0 *00000130 PrmServ 00000200 ConnWait 0.0.0.0 (1235)
LOADD0 *00000132 PrmServ 00000210 ConnWait 0.0.0.0 (1236)
TVIO0 *00000134 PrmServ 00000190 ConnWait 0.0.0.0 (1237)

* = Tapable with comtap
>NET>

Note that in the above output, the IP address and port number listed for the ESTD0 
server is that of the host connected to the Wind River ICE SX. 

NOTE:  In the above example, although the ICE is connected to a PPC750FX target, 
the firmware file is listed as PPC6xx; this is because PPC6xx and PPC7xx targets 
use the same firmware .bin file.
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Additional servers can be added to Wind River ICE SX as additional applications 
are ported to be used with the ICE solution. Simple Flash firmware updates can 
make these servers available.

3.5  Configuring Wind River ICE SX for Network Operation

When you first receive your ICE unit, you must correctly program the hardware 
for network operation.

You must configure the ICE unit for network operation before you can access it on 
your network, regardless of whether the physical connections have been made. 

The ICE contains a special boot mode that includes an Ethernet Setup (ETHSETUP) 
menu, which facilitates programming site specific network information into its 
non-volatile memory (NVRAM). This section describes the ETHSETUP menu. 

Before you configure the Wind River ICE SX for network operation, make sure that 
you have correctly installed the Wind River Workbench software and made serial 
connections between ICE and the host computer, and that power has been applied 
to the ICE unit as described in 2. Hardware Setup.

Before configuring the ICE for network operation, make sure you have the 
following information:

■ Know how you want to determine your IP address (the four available methods 
are described in 3.4 IP Addressing, p.37).

■ If you are planning to program the IP address manually, make sure that you 
know the address that you intend to assign to your unit (this information can 
be obtained from your system administrator).

■ Know how you want to determine your netmask (either entering it manually 
or by using one of the protocols that can provide the netmask).

NOTE:  Until you configure the ICE for network operation, it will not be visible on 
your network.

NOTE:  You do not need to have the Wind River ICE SX connected to a target in 
order to configure it for network operation. However, being connected to a target 
does not prevent you from configuring the ICE.
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■ Know how you want to set up routing on the ICE unit (no routing, manually 
entering tables, or dynamic routing).

■ If you plan to manually enter a routing table, make sure that you know the 
routing tables to be programmed.

■ If you plan to use a default route, make sure you know what that should be for 
your network. 

3.5.1  Opening a Serial Connection to Wind River ICE SX

You can configure the ICE for network operation over a direct serial connection 
between Wind River ICE SX and a host computer.

To establish a serial connection with the Wind River ICE SX, use the following 
steps.

1. Make a physical serial connection between the Wind River ICE SX and the 
host computer. Information about how to make this connection is available in 
2. Hardware Setup. 

2. Make sure that the power supply is attached to the ICE unit, but that the power 
switch is in the OFF position.

3. Launch Wind River Workbench using the method for your host operating 
system.

For Linux/Solaris hosts:

From your installation directory, enter the command ./startWorkbench.sh.

For Windows hosts:

Select Start > All Programs > Wind River > Wind River Workbench version.

NOTE:  Details about each of these items are available in 3.3 Networking Overview, 
p.37. In addition, you may need to contact your network administrator to find out 
the specific addresses for your network.

NOTE:  Establish serial connections with Wind River ICE SX using Wind River 
Workbench. From this point on, this chapter assumes that you have installed 
Wind River Workbench on your host computer. For information on Wind River 
Workbench, see the Wind River Workbench User’s Guide.
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4. If this is the first time you have opened Workbench, the Welcome screen 
appears. Click Workbench.

Workbench opens showing the Quick Target Launch dialog.

5. In the Quick Target Launch dialog, click Close.

6. In the Workbench toolbar, select Window > Show View > Terminal.

The Terminal view opens.

7. In the Terminal view, click the Settings button.

The Terminal Settings dialog appears.

8. Make sure Connection Type is set to Serial, and select the options that apply 
to the serial port Wind River ICE SX is connected to.

9. When you have finished defining the port, click OK. 

The Terminal view now displays an open connection.
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Once you have opened a serial connection, you can begin to configure the 
Wind River ICE SX for network operation. 

3.5.2  The Ethsetup Menu

Now that you have opened a serial connection, turn the Wind River ICE SX power 
switch to the ON position. After a second or two, the ICE runs through a series of 
internal tests to ensure all the hardware and firmware in the unit is functioning 
correctly. As the tests are run, they are displayed in the Terminal view in 
Wind River Workbench. The output resembles the following:

****************************************************************************
Wind River ICE Ethernet Platform
Copyright © Wind River Systems, Inc. 1999-2004.  All rights reserved
****************************************************************************
Firmware Type Wind River ICE BSP  Version 2.0a  Created On: Oct 22 2004 
16:07:17

Configuring TCP/IP Network Suite:
   IP Address..... NVRAM = 255.255.255.255
   Netmask........ NVRAM = 0xFFFF0000
   Default Gateway None
   Routing........ Disabled
   MAC Address.... 00:A0:1E:00:3C:71

Supervisory command mode enabled..................... PASSED
Pseudo device initialization......................... PASSED
TFTP device initialized.............................. PASSED
Device inititalized.................................. PASSED
Starting TCP/IP on PORT A 10BaseT.................... PASSED
Starting TCP/IP on PORT B 100BaseT................... PASSED
Initializing FFS Driver.............................. PASSED
FFS disk initialized  26408 Kbytes free.............. PASSED
FFS disk 0 percent fragmented................... PASSED
Disk volume 45.0.0 initialization.................... PASSED
Starting TCP TGTCONS   server TGTCONS [ 1232] ....... PASSED
Setting TGTCONS baud rate to 9600.................... PASSED
Starting WRS shell server............................ PASSED
Wind River ICE System Shell - Type HELP for list of commands

>NET> 

At the conclusion of these tests, a >NET> prompt appears in the Terminal view.

NOTE:  If you are having difficulty getting the serial connection to open properly, 
check to make sure that you have no other software running that is attempting to 
utilize that port. For example, Palm Pilot HotSync software maintains an open 
connection to the serial port whenever it is active.
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At the >NET> prompt, type ETHSETUP. The following information is displayed:

>NET>ethsetup

Ethernet Setup Mode

Select from the operations below
1. Display Basic IP parameters 2. Modify Basic IP parameters
3. Display Routing parameters 4. Modify Routing parameters
5. Display Server parameters 6. Modify Server parameters
7. View ethernet address 8. Save parameters
9. Exit setup mode 10. Port A/B select
11. Advanced Options

Make a selection: 

The Ethernet Setup menu presents a list of options you can use to configure the 
Wind River ICE SX for network operation. Any of the eleven options can be 
selected by entering its number and pressing ENTER. The available options are 
described below. 

Display Basic IP Parameters

Selecting this option displays how the ICE unit is currently set up to acquire its IP 
address, netmask, and default route. When you select this option, and the 
Wind River ICE SX is set to acquire its IP address using DHCP, the Terminal view 
displays the following output:

Make a selection: 1
System DNS name is: ICE
System IP address will be determined using DHCP
DHCP retry delay is LINEAR
System netmask will be determined using DHCP
System will not use a Default Gateway

Select from the operations below
1. Display Basic IP parameters 2. Modify Basic IP parameters
3. Display Routing parameters 4. Modify Routing parameters
5. Display Server parameters 6. Modify Server parameters
7. View ethernet address 8. Save parameters
9. Exit setup mode 10. Port A/B select
11. Advanced Options

Make a selection: 
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Modify Basic IP Parameters

Option 2 lets you modify how the ICE unit acquires its IP address, netmask, and 
default route. Answering a series of questions lets you modify how ICE is 
configured.For more information on this option, see Programming the IP Address, 
Netmask, and Default Gateway, p.53.

Display Routing Parameters

Option 3 lets you display the routing information that is currently set up on the 
Wind River ICE SX unit. It also displays any routing tables that are currently 
programmed into the NVRAM of the ICE unit.

Modify Routing Parameters.

Option 4 lets you modify how Wind River ICE SX acquires its routing tables, and 
lets you program any routes into the NVRAM. For more information on using this 
option, see Setting Up Routing, p.60.

Display Server Parameters

Option 5 lets you view the IP port numbers used by the servers that are in use on 
the ICE unit. These are the ports that the servers listen to for client connections.

Modify Server Parameters

Option 6 lets you modify the IP port numbers that are listened to by the servers for 
client connections. 

View Ethernet Address

Option 7 displays the MAC address of your Wind River ICE SX unit.
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Save Parameters

Option 8 saves any modifications you may have made to the IP address, routing 
information, and server parameters in the ICE NVRAM.

Exit Setup Mode

Option 9 exits Ethernet Setup mode. You must reset the Wind River ICE SX after 
exiting for your changes to take effect. 

Port A/B Select

Option 10 lets you change which Ethernet port on the ICE unit is used for Ethernet 
communications. By default, this option is set to automatically detect which port 
is being used. You can elect to force the unit to use either the 10BaseT or the 
10/100BaseT port at all times. 

3.5.3  Programming Wind River ICE SX Step-by-Step

This section provides a step by step list of things to do to configure the 
Wind River ICE SX for network operation. 

Programming the IP Address, Netmask, and Default Gateway

At this point, you should know which of the four methods of assigning an IP 
address you want to use. The choices are DHCP, manually assigning an address, 
BOOTP, and RARP, and there is detailed information on all of these protocols in 
3.3 Networking Overview, p.37. Please choose a method, then refer to the 
appropriate section below. 

Using DHCP

DHCP is the easiest method of configuring Wind River ICE SX for network 
operation, and ICE is set to use this protocol by default. Provided that your 
network has a DHCP server capable of handing out dynamic IP addresses, work 
through the following steps to configure ICE for network operation using the 
Dynamic Host Configuration Protocol.

1. At the >NET> prompt in the Terminal view, type ETHSETUP and press ENTER.
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2. Select Option 1 and press ENTER. 

The options that the ICE unit is currently set to are displayed. The options that 
are shipped on the ICE unit by default are as follows:

System DNS name is: ICE
System IP address will be determined using DHCP
DHCP retry delay is LINEAR
System Netmask will be determined using DHCP
System will not use a Default Gateway

3. Select Option 2 and press ENTER.

This allows you to change the default settings for your network:

How should the system determine its address? 
1. Enter the IP manually
2. Use the BOOTP Protocol
3. Use the RARP Protocol
4. Use the DHCP Protocol

Select a method [1]: 

4. To have the ICE unit determine its IP address using DHCP, select Option 4 
from the displayed list and press ENTER. 

5. Choose whether you want the DHCP retry delay to be linear (the default) or 
exponential by typing L or E, respectively.

A linear retry delay means that the ICE unit sends out a packet to the DHCP 
server in regular intervals, for example every ten seconds. An exponential 
retry delay means that instead of sending packets at regular intervals, ICE 
leaves an exponentially longer delay each time it sends a packet. For example, 
it might leave two seconds between the first and second packets, four seconds 
between the second and third, sixteen seconds between the third and fourth, 
and so on. In most cases, leaving a linear delay is acceptable.

6. The DNS Name option is not implemented at this time. Press ENTER to bypass 
this menu option. 

7. Specify the way that you would like the ICE unit to acquire the netmask.

If you are using DHCP to determine the IP address, it may be easiest to 
determine the netmask using DHCP as well. If you prefer, you can use one of 
the other methods. If you select the Determine Netmask from IP class option, 
the ICE unit calculates the netmask for your network based on the IP address. 
The Use ICMP Netmask Request option is a request that includes the IP 
address and is sent to a gateway on the network. The gateway responds with 
the netmask.

8. Specify whether the Wind River ICE SX unit should use a default gateway. 
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By default, this option is set to No. If you enter Yes, you must also enter the IP 
address of the gateway that you want to use. 

You are returned to the main Ethsetup menu.

9. To save the changes in the ICE unit’s NVRAM, select Option 8 and press 
ENTER.

10. To exit the ETHSETUP menu, select Option 9 and press ENTER. 

You are returned to a >NET> prompt in the Terminal view.

11. To make your changes take effect, power cycle the Wind River ICE SX. 

The ICE unit runs through the same series of internal tests as on initial startup, 
making sure that all the hardware and firmware in the unit is functioning 
correctly. These tests are again displayed in the Terminal view in Wind River 
Workbench. When they conclude, the > NET > prompt is again visible.

12. At the >NET> prompt, type ETHSETUP to view the networking options, select 
Option 1 from the menu, and press ENTER. 

The networking parameters that you programmed in the preceding steps are 
displayed.

You have now correctly specified the IP address, netmask, and default gateway for 
your ICE unit using DHCP. For information on configuring routing for your 
network, see Setting Up Routing, p.60. 

Manual Configuration

To manually assign an IP address, a netmask, and a default gateway to your 
Wind River ICE SX unit, follow the steps below. Prior to beginning, you should 
know the IP address that you want to assign to the ICE unit. You should also know 
the netmask that is required for your network. If you are unsure of either of these 
addresses, contact your network administrator to obtain the correct information. 

1. At the >NET> prompt in the Terminal view, type ETHSETUP and press ENTER.

2. Select Option 1 and press ENTER. 

The options that the ICE unit is currently set to are displayed. The options that 
are shipped on the ICE unit by default are as follows:

System DNS name is: ICE
System IP address will be determined using DHCP
DHCP retry delay is LINEAR
System Netmask will be determined using DHCP
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System will not use a Default Gateway

3. Select Option 2 and press ENTER.

This allows you to change the default settings for your network:

How should the system determine its address? 
1. Enter the IP manually
2. Use the BOOTP Protocol
3. Use the RARP Protocol
4. Use the DHCP Protocol

Select a method [1]: 

4. To set your IP address manually, select Option 1 and press ENTER. 

5. Enter the IP address for the ICE unit in dot format.

6. Specify the way you want the Wind River ICE SX unit to acquire the netmask. 

If you are manually programming the IP address, it is most common to 
program the netmask manually as well. If you choose to enter it manually 
using Option 1, you are prompted to enter the address in the next step. If you 
prefer, however, you may elect to use one of the other methods. The 
Determine Netmask From IP Class option sets the ICE unit to calculate the 
netmask for your network based on the IP address. The Use ICMP Netmask 
Request option is a request that includes the IP address and is sent to a 
gateway on the network. The gateway responds with the netmask.

7. Specify whether you would like the ICE unit to use a default gateway.

By default, this option is set to No. If you enter Yes, you must also enter the IP 
address of the gateway that you want to use. 

You are returned to the main ETHSETUP menu. 

8. To save the changes in the ICE unit’s NVRAM, select Option 8 and press 
ENTER.

9. To exit the ETHSETUP menu, select Option 9 and press ENTER. 

You are returned to a >NET> prompt in the Terminal view.

10. To make your changes take effect, power cycle the Wind River ICE SX. 

The ICE unit runs through the same series of internal tests as on initial startup, 
making sure that all the hardware and firmware in the unit is functioning 

NOTE:  Make sure that you have the correct address for your ICE unit, and that 
you enter it carefully. The IP address you enter will remain with your unit until 
you reprogram it.
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correctly. These tests are again displayed in the Terminal view in Wind River 
Workbench. When they conclude, the > NET > prompt is again visible.

11. At the >NET> prompt, type ETHSETUP to view the networking options, select 
Option 1 from the menu, and press ENTER. 

The networking parameters that you programmed in the preceding steps are 
displayed.

You have now correctly specified the IP address, netmask, and default gateway for 
your ICE unit. For information on configuring routing for your network, see 
Setting Up Routing, p.60. 

Using BOOTP

Assigning an IP address and a netmask to the ICE unit using the Bootstrap protocol 
is a fairly simple process. The following steps describe programming ICE for 
network operation using BOOTP. 

1. At the >NET> prompt in the Terminal view, type ETHSETUP and press ENTER.

2. Select Option 1 and press ENTER. 

The options that the ICE unit is currently set to are displayed. The options that 
are shipped on the ICE unit by default are as follows:

System DNS name is: ICE
System IP address will be determined using DHCP
DHCP retry delay is LINEAR
System Netmask will be determined using DHCP
System will not use a Default Gateway

3. Select Option 2 and press ENTER.

This allows you to change the default settings for your network:

How should the system determine its address? 
1. Enter the IP manually
2. Use the BOOTP Protocol
3. Use the RARP Protocol
4. Use the DHCP Protocol

Select a method [1]: 

4. To set your IP address using BOOTP, select Option 2 and press ENTER. 

5. Choose whether you want the BOOTP retry delay to be linear (the default) or 
exponential by typing L or E, respectively. 
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A linear retry delay means that the ICE unit sends out a packet to the BOOTP 
server in regular intervals, such as every ten seconds. An exponential retry 
delay means that instead of sending packets at regular intervals, the 
Wind River ICE SX leaves an exponentially longer delay each time it sends a 
packet. For example, it might leave two seconds between the first and second 
packets, four seconds between the second and third, sixteen seconds between 
the third and fourth, and so forth. In most cases, leaving a linear delay is 
acceptable.

6. Specify the way that you would like the ICE unit to acquire the netmask. 

If you are using BOOTP to determine the IP address, it may be easiest to 
determine the netmask using BOOTP as well. If you prefer, however, you may 
elect to use one of the other methods. The Determine Netmask From IP Class 
option sets the ICE unit to calculate the netmask for your network based on 
the IP address. The Use ICMP Netmask Request option is a request that 
includes the IP address and is sent to a gateway on the network. The gateway 
responds with the netmask.

7. Specify whether you want the ICE unit to use a default gateway. 

By default, this option is set to No. If you enter Yes, you must also enter the IP 
of the gateway that you want to use. 

You are returned to the main ETHSETUP menu. 

8. To save the changes in the ICE unit’s NVRAM, select Option 8 and press 
ENTER.

9. To exit the ETHSETUP menu, select Option 9 and press ENTER. 

You are returned to a >NET> prompt in the Terminal view.

10. To make your changes take effect, power cycle the Wind River ICE SX. 

The ICE unit runs through the same series of internal tests as on initial startup, 
making sure that all the hardware and firmware in the unit is functioning 
correctly. These tests are again displayed in the Terminal view in Wind River 
Workbench. When they conclude, the > NET > prompt is again visible.

11. At the >NET> prompt, type ETHSETUP to view the networking options, select 
Option 1 from the menu, and press ENTER. 

The networking parameters that you programmed in the preceding steps are 
displayed.
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You have now correctly specified the IP address, netmask, and default gateway for 
your ICE unit using BOOTP. For information on configuring routing for your 
network, see Setting Up Routing, p.60. 

Using RARP

Using RARP to assign an IP address to the ICE unit is a simple process. However, 
unlike the other protocols, RARP is only capable of obtaining the IP address. The 
netmask (and the default gateway, if one is being used) must still be programmed 
manually. Work through the following steps to program ICE for network operation 
using RARP. 

1. At the >NET> prompt in the Terminal view, type ETHSETUP and press ENTER.

2. Select Option 1 and press ENTER. 

The options that the ICE unit is currently set to are displayed. The options that 
are shipped on the ICE unit by default are as follows:

System DNS name is: ICE
System IP address will be determined using DHCP
DHCP retry delay is LINEAR
System Netmask will be determined using DHCP
System will not use a Default Gateway

3. Select Option 2 from the Ethsetup menu in the Terminal view of Wind River 
Workbench. 

This allows you to change the default settings for your network:

How should the system determine its address? 
1. Enter the IP manually
2. Use the BOOTP Protocol
3. Use the RARP Protocol
4. Use the DHCP Protocol

Select a method [1]: 

4. To set your IP address using RARP, select Option 3 and press ENTER. 

5. Specify the way that you would like the ICE unit to acquire the netmask.

If you are using RARP to determine the IP address, it may be easiest to 
program the netmask manually. If you choose to enter it manually (Option 1), 
you are prompted to enter the address in the next step. If you prefer, however, 
you may elect to use one of the other methods. The Determine Netmask from 
IP class option sets the ICE unit to calculate the netmask for your network 
based on the IP address. The Use ICMP Netmask Request option is a request 
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that includes the IP address and is sent to a gateway on the network. The 
gateway responds with the netmask.

6. Specify whether or not you would like the ICE unit to use a default gateway.

By default, this option is set to No. If you enter Yes, you must also enter the IP 
of the gateway that you want to use.

You are returned to the main ETHSETUP menu.

7. To save the changes in the ICE unit’s NVRAM, select Option 8 and press 
ENTER.

8. To exit the ETHSETUP menu, select Option 9 and press ENTER. 

You are returned to a >NET> prompt in the Terminal view.

9. To make your changes take effect, power cycle the Wind River ICE EX. 

The ICE unit runs through the same series of internal tests as on initial startup, 
making sure that all the hardware and firmware in the unit is functioning 
correctly. These tests are again displayed in the Terminal view in Wind River 
Workbench. When they conclude, the > NET > prompt is again visible.

10. At the >NET> prompt, type ETHSETUP to view the networking options, select 
Option 1 from the menu, and press ENTER. 

The networking parameters that you programmed in the preceding steps are 
displayed.

You have now correctly specified the IP address, netmask, and default gateway for 
your Wind River ICE SX unit using RARP. For information on configuring routing 
for your network, see Setting Up Routing, p.60. 

Setting Up Routing

If your network is designed in such a way that routing information is necessary, 
the Wind River ICE SX needs to be set up to account for that. Before beginning, 
decide if you want the ICE to determine the routing information dynamically, to 
program static routing tables into the ICE’s memory, or whether you want to 
disable routing on your unit. The following sections describe how to enable or 
disable routing for the ICE unit. Refer to the appropriate section for configuring 
your unit for the network. 
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Configuring Dynamic Routing

If the network on which the Wind River ICE SX is being run uses the Routing 
Information Protocol (RIP), configuring routing information on the ICE unit 
dynamically is the best option, since once the unit is set up, it automatically detects 
any changes that occur on the network and updates the unit appropriately. Work 
through the steps shown below to configure the ICE to use dynamic routing.

1. At the >NET> prompt in the Terminal view, type ETHSETUP and press ENTER.

2. Select Option 3 and press ENTER. 

The routing options that the ICE unit is currently set for are displayed. By 
default, ICE is shipped with routing disabled.

Routing is disabled.

3. Select Option 4 and press ENTER. 

This allows the routing information in ICE to be modified to suit your 
network.

4. From the list that displays, select Option 3 - Enable routing using the RIP 
protocol.

5. Next, you are asked to enter how many route entries you want stored in the 
ICE unit at run-time. 

For example, consider the case where you have 25 routes specified. As your 
network system propagates new routes, these routes are stored in the routing 
table in the ICE unit until 25 routes are stored. When the table reaches 25 
routes, the oldest unused routes are replaced by any new ones that are 
propagated. If a new route arrives that supersedes a route already stored in the 
tables, the new route replaces the existing route. 

At this point, you are returned to the main Ethsetup menu. 

6. To save the changes in the ICE unit’s NVRAM, select Option 8 and press 
ENTER.

7. To exit the ETHSETUP menu, select Option 9 and press ENTER. 

You are returned to a >NET> prompt in the Terminal view.

8. To make your changes take effect, power cycle the Wind River ICE SX. 

The ICE unit runs through the same series of internal tests as on initial startup, 
making sure that all the hardware and firmware in the unit is functioning 
correctly. These tests are again displayed in the Terminal view in Wind River 
Workbench. When they conclude, the > NET > prompt is again visible.
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9. At the >NET> prompt, type ETHSETUP to view the networking options, select 
Option 1 from the menu, and press ENTER. 

The networking parameters that you programmed in the preceding steps are 
displayed.

You have now configured dynamic routing for your ICE unit. For information on 
saving and testing your configuration, see Saving Network Setup Information, p.66. 

Configuring Static Routing

If the network on which ICE is being run is not designed on the Routing 
Information Protocol (RIP), you must configure a static routing table to be stored 
in the Wind River ICE SX unit. A static routing table is one that is stored in the ICE 
unit’s NVRAM and is added to the run-time routing table when the unit is booted.

Both network routes and host routes can be stored in the static table of the ICE unit. 
A network route tells ICE that in order to access Network X, the packets should be 
addressed to Host Y. A host route tells the ICE unit that in order to get to Host A, 
the packet should be addressed to Host B. In these cases, Host Y and Host B are 
essentially routers, since they have more than one network connection.

To program the ICE with a static routing table, use the following steps.

1. At the >NET> prompt in the Terminal view, type ETHSETUP and press ENTER.

2. Select Option 3 and press ENTER. 

The routing options that the ICE unit is currently set for are displayed. By 
default, ICE is shipped with routing disabled.

Routing is disabled.

3. Select Option 4 and press ENTER. 

This allows the routing information in ICE to be modified to suit your 
network.

4. From the list that displays, select Option 2 - Enable routing using static route 
table.

5. Next, you are asked to specify how many route entries should be in the ICE 
unit at runtime. 

NOTE:  Before continuing, make sure that you know what routes you want to 
program into the Wind River ICE SX unit. Also, exercise caution when entering the 
data and make sure that each address is correct before moving on to the next step.
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A table appears displaying the number of routes you have specified in the 
previous step, as shown below:

How many route entries should be in the run-time route table [25]: 10

Current static route table entries are:
[01] Dest Net 0.0.0.0 --> 0.0.0.0 Status: Disabled
[02] Dest Net 0.0.0.0 --> 0.0.0.0 Status: Disabled
[03] Dest Net 0.0.0.0 --> 0.0.0.0 Status: Disabled
[04] Dest Net 0.0.0.0 --> 0.0.0.0 Status: Disabled
[05] Dest Net 0.0.0.0 --> 0.0.0.0 Status: Disabled
[06] Dest Net 0.0.0.0 --> 0.0.0.0 Status: Disabled
[07] Dest Net 0.0.0.0 --> 0.0.0.0 Status: Disabled
[08] Dest Net 0.0.0.0 --> 0.0.0.0 Status: Disabled
[09] Dest Net 0.0.0.0 --> 0.0.0.0 Status: Disabled
[10] Dest Net 0.0.0.0 --> 0.0.0.0 Status: Disabled

Enter the number of the route to change (0 to exit):

In the above example, ten routes are specified, and as a result the table shows 
ten routes, numbered 1-10 on the left side of the figure.

6. Next, specify the number of the route you want to change. 

For example, if you wanted to modify the first route in the table, you would 
type 1 and press ENTER. 

7. Specify whether you would like to edit or delete the entry specified. 

If you choose to delete the entry, it is replaced with a blank entry—all zeroes.

If you choose to edit an entry, you are first asked to enter whether you want to 
program a host route or a network route. Type either H (for host route) or N 
(for network route) and press ENTER.

8. Next you are asked for the IP address of either the destination host or the 
destination network, depending on which type of route you are creating. Enter 
the IP address in dot format and press ENTER.

9. You now have to enter the IP address of the next hop gateway to the 
destination host or network IP address that you specified in the last step. 

This is the address of the router that packets should be addressed to in order 
to reach a host or network on the other side of that router. Enter the IP address 
in dot format and press ENTER.

10. You are returned to the table, as shown below:

Enter the number of the route to change (0 to exit): 1

Do you want to delete or edit this entry (D or E): e

Is this a Host or Network Route (H or N): n
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Enter the IP address of the destination network [0.0.0.0]: 199.2.201.0

Enter the IP address of the next hop gateway to 199.2.201.0 [0.0.0.0]: 
199.2.200.1

Current static route table entries are:
[01] Dest Net 199.2.201.0 --> 199.2.200.1 Status: Enabled
[02] Dest Net 0.0.0.0 --> 0.0.0.0 Status: Disabled
[03] Dest Net 0.0.0.0 --> 0.0.0.0 Status: Disabled
[04] Dest Net 0.0.0.0 --> 0.0.0.0 Status: Disabled
[05] Dest Net 0.0.0.0 --> 0.0.0.0 Status: Disabled
[06] Dest Net 0.0.0.0 --> 0.0.0.0 Status: Disabled
[07] Dest Net 0.0.0.0 --> 0.0.0.0 Status: Disabled
[08] Dest Net 0.0.0.0 --> 0.0.0.0 Status: Disabled
[09] Dest Net 0.0.0.0 --> 0.0.0.0 Status: Disabled
[10] Dest Net 0.0.0.0 --> 0.0.0.0 Status: Disabled

Enter the number of the route to change (0 to exit):

The information that you entered is visible in the appropriate route table entry. 
For example, if you elected to change entry 01 in the table, the IP addresses you 
entered are visible in line 01 of the table. Notice also that the entry has 
automatically been enabled. This means that at run-time, the ICE unit includes 
that entry as one of the possible routes. 

11. Repeat steps 4-10 as many times as necessary to fill the entries in your table. 

As each entry is added, its status is changed to Enabled. Any entries you 
choose to leave blank remain disabled, and are not included as one of the 
possible routes at run-time.

12. When you are satisfied that all of the entries have been filled out correctly, type 
0 at the prompt, and press ENTER to exit. 

You are returned to the main Ethsetup menu.

13. To save the changes in the ICE unit’s NVRAM, select Option 8 and press 
ENTER.

14. To exit the ETHSETUP menu, select Option 9 and press ENTER. 

You are returned to a >NET> prompt in the Terminal view.

15. To make your changes take effect, power cycle the Wind River ICE SX. 

The ICE unit runs through the same series of internal tests as on initial startup, 
making sure that all the hardware and firmware in the unit is functioning 
correctly. These tests are again displayed in the Terminal view in Wind River 
Workbench. When they conclude, the > NET > prompt is again visible.

16. At the >NET> prompt, type ETHSETUP to view the networking options, select 
Option 1 from the menu, and press ENTER. 
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The networking parameters that you programmed in the preceding steps are 
displayed.

You have now configured dynamic routing for your ICE unit. For information on 
saving and testing your configuration, see Saving Network Setup Information, p.66. 

Disabling Routing

If you do not require that Wind River ICE SX store any routing table information 
in its NVRAM, either static or dynamically programmed, then you can disable 
routing.

To disable routing on your ICE unit:

1. At the >NET> prompt in the Terminal view, type ETHSETUP and press ENTER.

2. Select Option 3 and press ENTER. 

The routing options currently set for the ICE unit appear. By default, the ICE 
is shipped with routing disabled, and the following line appears when Option 
3 is selected:

Routing is disabled.

If your Wind River ICE SX unit is in the default configuration with routing 
disabled, proceed to Saving Network Setup Information, p.66. If your ICE unit is 
not in the default configuration, proceed to the next step.

3. Select Option 4 and press ENTER.

This allows the routing information in the ICE to be modified to suit your 
network.

4. From the list that appears, select Option 1 - Disable routing.

You are returned to the main Ethsetup menu.

5. To save the changes in the ICE unit’s NVRAM, select Option 8 and press 
ENTER.

6. To exit the ETHSETUP menu, select Option 9 and press ENTER. 

You are returned to a >NET> prompt in the Terminal view.

NOTE:  Disabling routing in this case does not mean disabling the default route. 
You can disable routing using the Modify Routing Parameters option and still 
have a default route programmed.
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7. To make your changes take effect, power cycle the Wind River ICE SX. 

The ICE unit runs through the same series of internal tests as on initial startup, 
making sure that all the hardware and firmware in the unit is functioning 
correctly. These tests are again displayed in the Terminal view in Wind River 
Workbench. When they conclude, the > NET > prompt is again visible.

8. At the >NET> prompt, type ETHSETUP to view the networking options, select 
Option 1 from the menu, and press ENTER. 

The networking parameters that you programmed in the preceding steps are 
displayed.

You have now configured dynamic routing for your ICE unit. For information on 
saving and testing your configuration, see Saving Network Setup Information, p.66. 

Saving Network Setup Information 

You have now programmed all the information into the ICE unit that is required to 
make it visible on your network. Save and exit the Ethsetup menu by selecting 
Option 8 and pressing ENTER, and then select Option 9 and pressing ENTER. You 
are returned to a >NET> prompt. 

Turn off the ICE unit. If you have not yet connected your Wind River ICE SX unit 
to a network device, refer to 2.6.2 Ethernet Connections, p.22, and make these 
connections now. 

Turn on the ICE unit. This will reset it and allow all the network configuration 
options to take effect, and allow you to test the configuration.

As the unit boots, you can watch it perform the standard boot up sequence, which 
includes attempting to initialize the Ethernet interface. Any problems that are 
encountered while the ICE unit is booting, for example no RARP server 
responding, are displayed on the screen during this process. The boot up sequence 
where the Ethernet interface is initialized using DHCP is shown below.

****************************************************************************
Wind River ICE Ethernet Platform
Copyright © Wind River Systems, Inc. 1999-2004.  All rights reserved
****************************************************************************
Firmware Type Wind River ICE BSP  Version 2.0a  Created On: Oct 22 2004 
16:07:17

Configuring TCP/IP Network Suite:
   IP Address..... DHCP

DHCP: Sending DISCOVER 0 - 1 - +
DHCP: OFFER received
DHCP: Sending REQUEST 0 - 1 - +
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DHCP: ACK received
DHCP Server at 255.52.25.255 returned IP address 255.5.2.255
DHCP IP address 255.52.25.255 lease time - 7 days, 0 hours, 0 min
Netmask........ DHCP = 0xFFFF0000

   Default Gateway DHCP = 255.0.0.1
   Routing........ Disabled
   MAC Address.... 00:A0:1E:00:32:E7

Supervisory command mode enabled..................... PASSED
Pseudo device initialization......................... PASSED
TFTP device initialized.............................. PASSED
Device inititalized.................................. PASSED
Starting TCP/IP on PORT A 10BaseT.................... PASSED
Starting TCP/IP on PORT B 100BaseT................... PASSED
Initializing FFS Driver.............................. PASSED
FFS disk initialized  26408 Kbytes free.............. PASSED
FFS disk 0 percent fragmented................... PASSED
Disk volume 45.0.0 initialization.................... PASSED
Starting TCP TGTCONS   server TGTCONS [ 1232] ....... PASSED
Setting TGTCONS baud rate to 9600.................... PASSED
Starting WRS shell server............................ PASSED
Wind River ICE System Shell - Type HELP for list of commands

>NET> 

If the ICE unit encounters errors during the attempt to initialize the Ethernet 
interface, it will still boot. However, the Ethernet interface will not be enabled. 

Testing the Installation

Once the Wind River ICE SX has been connected to the network and reset properly, 
it is accessible from the network. The Ping and Telnet diagnostics, available on 
most TCP/IP hosts, allow this to be verified.

The Ping utility is available on all UNIX and Windows hosts. Ping sends a packet 
to a network address and has that address echoed back within a certain time 
period. To ping your ICE unit, type the following information at any prompt:

ping addr

addr is the IP address of your ICE unit in dot format.

A response such as

Reply from 255.52.25.255: bytes=32 time<10ms TTL=255

is returned. 

A second utility that is widely available on most hosts is Telnet. Telnet is a terminal 
emulation package that lets you log into a network node. The ICE unit contains a 
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Telnet server, and you can use a UNIX or PC Telnet client to log in to the ICE unit 
by typing the following at any command prompt.

telnet addr

addr is the IP address of your ICE unit in dot format.

A Telnet window opens as shown in Figure 3-4.

If these tests execute successfully, it indicates that ICE is visible and active on the 
network. 

The Wind River ICE SX unit includes an implementation of the Ping utility that is 
available from the >NET> prompt. This can be used to test routing if either static or 
a dynamic routing has been set up on the ICE unit. From the >NET> prompt, try to 
ping hosts on each of the routed segments. This verifies that the ICE is correctly 
configured to route messages on your network. 

3.6  Using the Target Console (TGTCONS) Port 

In situations where the ICE is not connected directly to your host computer during 
configuration, you can open a serial channel to the target using the TGTCONS port 
on the front of the ICE unit. 

Before using the TGTCONS port, you must configure the Wind River ICE SX for 
network operation as described previously in this chapter.

Figure 3-4 Telnet Utility
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3.6.1  Connecting to the TGTCONS Port

To make the physical connections between the TGTCONS port on the ICE unit and 
the target, use the following steps.

1. Connect one end of an RS-232 cable to the TGTCONS port on the front of the 
ICE unit.

2. Connect the other end of the RS-232 cable into either the 9- or 25-pin female D 
subminiature adapter. 

3. Take a second RS-232 cable (two are included in your shipment) and plug it 
into the serial port on the target. 

4. Connect the other end of the second RS-232 cable (the one connected to the 
target) to either the 9- or 25-pin male D subminiature adapter. Make sure that 
you choose the same type of adapter (either 9 or 25 pins) as you used in Step 2. 

5. Connect the two 9- or 25-pin D subminiature adapters together to complete the 
connection between the target and the ICE unit. 

The following figures show the pins that are actually used in the TGTCONS port, 
the 25-pin adapter, and the 9-pin adapter.

Figure 3-5 TGTCONS Port

Table 3-4 TGTCONS Port Pin Scheme

Pin # Host (ICE) Target

Pin 3 Transmit Receive

Pin 2 Receive Transmit

Pin 5 Ground Ground
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Figure 3-6 25-Pin Male Adapter

Table 3-5 25-Pin Male Adapter Pin Scheme

Pin # Host (ICE) Target

Pin 2 Transmit Receive

Pin 3 Receive Transmit

Pin 7 Ground Ground

Figure 3-7 9-Pin Male Adapter

Table 3-6 9-Pin Male Adapter Pin Scheme

Pin # Host (ICE) Target

Pin 3 Transmit Receive

Pin 2 Receive Transmit

Pin 5 Ground Ground
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3.6.2  Configuring the Target Console Baud Rate

The Wind River ICE SX is set to use a serial baud rate of 9600 by default. If you 
want to use a baud rate of 9600, skip this section and go on to 3.6.3 Connecting to 
the Target, p.72. If you want to use a different baud rate, use the following steps.

1. At the >NET> prompt in the Terminal view, type ETHSETUP and press ENTER.

The ETHSETUP menu appears.

Ethernet Setup Mode
Select from the operations below

1. Display Basic IP parameters 2. Modify Basic IP parameters
3. Display Routing parameters 4. Modify Routing parameters
5. Display Server parameters 6. Modify Server parameters
7. View ethernet address 8. Save parameters
9. Exit setup mode 10. Port A/B select
11. Advanced Options

Make a selection:

2. Enter 5 and press ENTER.

Workbench displays the current settings of the server ports. By default the 
TGTCONS server uses port 1232 at 9600 baud.

Make a selection: 5

The ESTTOOLS server is assigned Port 1234
The TGTCONS server is assigned Port 1232 at 9600 Baud
The UDPCNSL server is disabled
The TCPCNSL server is assigned Port 1237

Select from the operations below
1. Display Basic IP parameters 2. Modify Basic IP parameters
3. Display Routing parameters 4. Modify Routing parameters
5. Display Server parameters 6. Modify Server parameters
7. View ethernet address 8. Save parameters
9. Exit setup mode 10. Port A/B select
11. Advanced Options

Make a selection: 

3. Enter 6 and press ENTER.

Make a selection: 6

[1] Server: ESTTOOLS Port: 1234
[2] Server: TGTCONS Port: 1232
[3] Server: UDPCNSL Disabled
[4] Server: TCPCNSL Port: 1237

Enter the number of the server to modify (0 to exit):
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4. Enter 2 and press ENTER.

Workbench prompts you for the port number.

Enter the Port for the TGTCONS   Server (0 to disable) [1232]:

5. Enter 1232 and press ENTER.

Enter the Port for the TGTCONS Server (0 to disable) [1232]: 1232

[1] 1200
[2] 1800
[3] 2400
[4] 4800
[5] 9600
[6] 19200
[7] 38400

Select a baud rate from the previous choices [5 (9600)]: 

6. Enter the number that corresponds to the baud rate you want. For instance, to 
use a baud rate of 19200, enter 6.

You are returned to the server list.

[1] Server: ESTTOOLS Port: 1234
[2] Server: TGTCONS Port: 1232
[3] Server: UDPCNSL Disabled
[4] Server: TCPCNSL Port: 1237

Enter the number of the server to modify (0 to exit): 

7. To exit the list, enter 0 and press ENTER.

You are returned to the ETHSETUP menu.

8. To save your changes, enter 8 and press ENTER.

9. To exit the ETHSETUP menu, enter 9 and press ENTER.

10. To make your changes take effect, power cycle the Wind River ICE SX.

3.6.3  Connecting to the Target 

To establish a serial connection to the target, use the following steps:

1. In the Terminal view, click the New Terminal button.

A second instance of the Terminal view opens. The first instance is now 
labeled Terminal 0 and this new instance is labeled Terminal 1.

2. In Terminal 1, click the Settings button.
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The Settings dialog appears.

3. In the Connection Type field, select Network.
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4. In the Host field, enter the IP address of your Wind River ICE SX.

5. In the Port field, select tgtcons.

6. Press ENTER to see your target boot prompt in Terminal 1.

To disconnect from the Target Console connection, click the Disconnect button in 
Terminal 1 and click on the X in the Terminal 1 tab to close it.

3.7  Network Command Reference

The Wind River ICE SX includes several network commands that can be used from 
the >NET> prompt. For a complete Wind River ICE SX command reference, 
including network commands, see the Wind River Workbench for On-Chip Debugging 
Command Reference. 

NOTE:  If your Wind River ICE SX is connected and attached to the target -- 
that is, if there is a >BKM> prompt in the OCD Command Shell -- then you 
will not get a target prompt, because the Wind River ICE SX has forced the 
target into background mode. To get the prompt, you must perform a hard 
reset of your target. This causes an “Unexpected target reset” error message in 
Workbench, and an >ERR> prompt appears in the OCD Command Shell.
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4.1  Introduction

After you have installed the Wind River Workbench software, connected the 
Wind River ICE SX hardware and configured it correctly for network operation, 
the next step is to establish communications with a target. 

The Wind River ICE SX uses the On-Chip Debugging (OCD) services that are 
embedded in the microprocessor of the target board. You can access these OCD 
services by using a BDM/JTAG/EJTAG connector on the target. Through the 
utilization of these OCD services, ICE is able to effectively control and monitor the 
processor. 
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Establish communications between Wind River ICE SX and the target using 
Wind River Workbench.

Wind River Workbench allows you to use either a graphical interface or low-level 
commands to work with the target. Once you have established communications 
with the target, Wind River recommends that you use the Wind River Workbench 
Graphical User Interface (GUI) to perform most tasks. For information on using the 
Wind River Workbench GUI to perform tasks with ICE and the target, see the 
Wind River Workbench for On-Chip Debugging User Tutorials. 

If you are more comfortable using low-level commands, you may do so from the 
OCD Command Shell in Wind River Workbench, as explained in this chapter. For 
a detailed low-level command reference, see the Wind River Workbench for On-Chip 
Debugging Command Reference.

4.2  Connecting to the Wind River ICE SX

Prior to attempting to establish communications with the target using the ICE, 
please make sure that:

■ All hardware is properly connected to the host and the target, and that the 
connections are tight (see 2. Hardware Setup for more information).

■ You have set the Wind River ICE SX up properly for operation on your 
network (see 3. Configuring Wind River ICE SX for Network Operation for more 
information).

■ You have applied power to both the ICE and the target board.

Establishing Communications

To establish communications with the Wind River ICE SX, use the following steps:

1. Launch Wind River Workbench according to the method for your host.

Linux/Solaris Hosts

NOTE:  This chapter assumes that you have Wind River Workbench installed and 
running on the host. For information on Wind River Workbench, see the 
Wind River Workbench User’s Guide.
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From your installation directory, issue the following command:

$ ./startWorkbench.sh 

Windows Hosts

Select Start > Programs > Wind River > Wind River Workbench 2.6.1 > Wind 
River Workbench version.

Wind River Workbench opens. 

2. Specify a workspace.

For Windows hosts, Workbench displays a dialog where you can specify a 
location for your workspace. For Linux hosts, the workspace defaults to 
installDir/workspace. 

After you specify your workspace, Workbench opens and the Quick Target 
Launch dialog appears.

The Quick Target Launch dialog allows you to create a launch configuration 
to initialize your target and download symbols and code. Once created, the 
launch configuration is persistent, so you can return to it at any time.

If this is the first time you have launched Workbench, the only available option 
is Create a new launch configuration. The next time you open Workbench, the 
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Quick Target Launch dialog will give you the option of re-launching the same 
launch configuration or creating a new one.

3. Select Create a new launch configuration.

The New Connection Wizard appears. 

4. Choose Wind River OCD ICE Connection from the list of options and click 
Next.
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The Communication Settings dialog appears. 

To configure communication settings manually, see Configuring Communication 
Settings Manually, p.79. To configure communication settings through a serial 
port, see Configuring Communication Settings Through a Serial Port, p.81.

Configuring Communication Settings Manually

5. Select the Configure Communication Settings Manually box and click Next.

The Emulator Settings dialog appears.

6. In the Designators area, enter your target processor type in the Processor field, 
or click Select to choose from a list of available processor types.

NOTE:  If you choose this option you will need to know either the network name 
of the emulator or its IP address. For information on assigning these values, see 
3. Configuring Wind River ICE SX for Network Operation.
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If you are using multiple processors, or if you have other devices besides your 
processor on your JTAG scan chain, you must specify a board file in the Board 
File field. Check the Board File radio button and click Browse to navigate to 
your board file.

Either choice will populate the field below the Board File field with a 
summary description of your board.

7. In the Communications area, fill in the IP Address field with the IP address 
you have assigned to your ICE unit.

8. When you have entered the correct processor or board file and IP address, click 
Next.
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The Target Operating System Settings dialog appears. Proceed to Step 12.

Configuring Communication Settings Through a Serial Port

If you choose to make your connection using the serial port, make sure that a serial 
cable is connected between Wind River ICE SX and your host computer.

a. Check the Configure Communication Settings Through a Serial Port box 
and click Next. The Serial Settings dialog appears.

b. Use this dialog to select the serial port you want to connect to, and set a 
timeout value in seconds. Communication settings, such as the emulator’s 
dynamically assigned IP address and other settings, will be retrieved and 
displayed automatically, as shown below.

NOTE:  A direct serial cable is required to create your connection this way. If you 
do not have a direct serial connection between your host and emulator, you must 
configure your ICE settings manually.
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The retrieved settings can also be modified (select the Modify checkbox); that 
is, you can reconfigure the emulator’s communication settings using a serial 
connection.

c. Click Next.

The Target Operating System Settings dialog appears.
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9. In the Booted Target OS on selected CPU field, select the operating system 
that is running on your target processor. The default is None.

10. Next to the Kernel Image field, click Browse to navigate to the kernel image 
you wish to specify. If you selected None in the previous step, you do not need 
to specify a kernel image.

11. If you are using a Linux plug-in specify the pass-through options in the Target 
OS Pass-Through Options field. If you are not using a Linux plug-in, skip this 
step.

Options are passed as pairs in the format name=value. Separate options with a 
comma. The following options are available:

■ notasklist=1 : Never fetch process list.
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■ noautomodules=1 : Do not plant internal breakpoints to do automatic 
kernel module load/unload detection. When this option is specified, you 
must manually refresh to see an updated module list.

■ noloadcheck=1 : Do not issue gophers until the hardware breakpoint is 
used to detect kernel load triggers. This option is for “sensitive” boards 
that don’t accept access until the kernel loads and sets up memory 
mapping.

■ loaddetectloc=symbol or address: Set the hardware breakpoint used to 
detect kernel load at symbol (for example, loaddetectloc=start_kernel) or 
address (for example, loaddetectloc=0x1000). If you do not specify a 
symbol or address, Workbench uses a default. For most architectures the 
default is start_kernel; for PowerPC targets, the default is 0x0.

12. Click Next.

The Memory Options dialog appears.
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Use the Memory Options dialog to specify how memory on the target is 
partitioned, and what the attributes of the particular memory regions are.

To specify an area of memory, click Add.

The Set Memory Map dialog appears.

Use the Set Memory Map dialog to specify which memory areas are read-only, 
read-write, or write-only, and to specify the access width Workbench should 
use to read the data from those regions.

13. Click Next.

The Object Path Mappings dialog appears. 

NOTE:  The Memory Options dialog is only necessary for Linux or other 
non-VxWorks target operating systems.
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Use the Object Path Mappings dialog to specify how files in the target file 
system are visible in the host file system.

14. To add a host or target path, click Add... and type the path in the dialog that 
appears.

15. Click Next.

The Target State Refresh dialog appears.
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Use the Target State Refresh dialog to configure the target state query and 
target state refresh settings on your target processor.

16. Click Next.

The Default Breakpoint Options dialog appears.
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Use this dialog to set default breakpoint options for newly created breakpoints.

17. Click Next.

The Connection Summary dialog appears. 
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18. Check the displayed values to make sure they are correct.

If you want to connect to your target now, select Immediately connect to 
target if possible. If you do not wish to connect to your target now, clear the 
Immediately connect to target if possible box. You can connect at any time by 
clicking Connect in the Launch Configuration dialog.

19. If you want to share your target connection, select Shared.

This option serves a dual purpose:

■ When you define a target connection configuration, this connection is 
normally only visible for your user-id. If you define it as Shared, other users 
can also see the configuration in your registry, provided that they connect to 
your registry by adding it as a remote registry on their computer.

■ Normally, when you disconnect a target connection, the target server (and 
simulator) are killed because they are no longer needed. In a connection that is 
flagged as Shared, however, they are left running so that other users can 
connect to them. In other words, you can flag a connection as shared if you 
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want to keep the target server (and simulator) running after you disconnect or 
exit Workbench.

20. Click Finish. 

Your target name appears in the Target Manager view. You can connect at any time 
by right-clicking on the target name in the Target Manager view and selecting 
Connect.

A >BKM> prompt appears in the OCD Command Shell.

Once the >BKM> prompt is visible, you are ready to begin debugging. For 
information on debugging and other procedures for the Wind River ICE SX, see 
the Wind River Workbench for On-Chip Debugging User Tutorials.

Workbench allows you to run and debug code either in combination with the 
Workbench project management facility, or without using a project. If you want to 
use a Workbench project to run and debug code, continue to 4.3 Setting Up a Project, 
p.90. If you want to run and debug code without using a Workbench project, skip 
to 4.4 Downloading Code, p.93.

4.3  Setting Up a Project

Several example projects are included in Wind River Workbench for 
demonstration purposes. To open a new demonstration project, use the following 
steps:

1. Select File > New > Example.

The New Example wizard appears.

NOTE:  If the OCD Command Shell is not visible on your desktop, click on 
Window in the toolbar and select Show View > OCD Command Shell.



4  Establishing Communications
4.3  Setting Up a Project

91

4

2. Select Standalone Sample Project and click Next.

The Sample Project template appears.
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3. Select C Demonstration Program and click Finish.

The project name c_demo_sa appears in the Project Navigator view.

4. Click on the “+” next to the project name to expand it.

A list of available build specs appear.
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4.4  Downloading Code

The Reset and Download view initializes your target and downloads an 
executable file. 

To perform a reset and download, use the following steps.

1. To open the Reset and Download view, highlight your target name in the 
Target Manager view and click the OCD Reset and Download button.

You can also right-click on your selected target name and choose Reset and 
Download... from the context menu.

The Reset and Download view opens, displaying the Main tab.
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4.4.1  Projects to Build Tab

1. Select the Projects to Build tab.

If you want Workbench to build your project before launching the reset and 
download operation, specify your project here. In the Projects to Build tab, 
select Add Project. From the list of available projects that appears, select the 
project you want to build and click OK.

This example shows the Projects to Build tab set to build the project 
c_demo_sa before launching.

NOTE:  To enable this operation, make sure your launching preferences are 
correctly set. In the Workbench toolbar, select Window > Preferences > 
Run/Debug > Launching. In the General settings for launching field, make sure 
the Build (if required) before launching checkbox is selected. This checkbox is 
selected by default.
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4.4.2  Reset Tab

1. Select the Reset tab.
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2. If you want to play a register file, select Play Register File and browse for the 
.reg file you want to use.

This example shows a Wind River PPMC750FX target; the Wind River register 
file for this target is ppmc750fx.reg, located in 
installDir/workbench-2.x/dfw/build/host/registers, in the directory 
PowerPC/7xx/WindRiver_PPMC.

If you do not want to reconfigure your target registers, leave this box 
unchecked.

3. Choose the type of reset initialization you want to perform.

You can use the IN or INN initialization commands. For a full discussion of 
these two commands, see 4.5.2 Initializing the Target, p.105.

You can also choose not to perform an initialization by clearing the Reset box.

4. Choose which core your reset and download will affect.

! CAUTION:  If you are manually changing registers on your target, be aware that 
issuing an IN or INN initialization command will overwrite your changes.
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In the Cores Tied on Reset field, you will see a list of all the cores on your JTAG 
scan chain. If you want your reset and download to affect only one core, click 
on that core in the Cores Tied on Reset field and check Specified Core. If you 
want your reset and download to affect all your target boards, click on All 
Cores.

4.4.3  Download Tab

1. Select the Download tab.

2. Click Add Files.

In the browser window that appears, navigate to the executable file you want 
to run. This example uses the PowerPC version of the executable cdemo.elf file 
from the sample C Demonstration Program.

The file you select appears in the Filename field. Repeat this process as many 
times as necessary. 

The file at the top of the list will download to the target first, followed by the 
others from the top down. You can edit the order of the list by clicking on any 
filename to highlight it and using the Up, Down, and Delete buttons.
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3. Use the other fields to configure the download.

Download

The Download field is checked by default. If you clear it, the file will remain 
on the list but will not download data to the target. This is useful if, for 
example, you only want to download symbol information and not data.

Verify

The Verify field configures the extent to which the file you are downloading 
will be compared to a file that may already be on the target. There are three 
options: Full, Compare, and None.

When this field is set to Full, a write/read verify will occur for every 
download. Workbench writes to the target and then verifies that the write to 
the target and the read from the target are identical. This is slower than a 
normal download, but it is a useful security option.

When the field is set to Compare, Workbench will verify that the image has 
been downloaded correctly (that is, that the image on the host is the same as 
the image on the target.) This is useful for programming flash. 

When the field is set to None, Workbench will perform no verification.

The Verify field is set to None by default.

Load Symbol

The Load Symbol field, which is checked by default, determines whether the 
file’s symbol information is downloaded to the target.

Offset

In the Offset field, you can enter a value in hex to set a memory offset bias for 
your application file. If you do not enter a value, Workbench uses the default 
value 0x00000000.

NOTE:  You should only set the Verify field to Compare if an image already 
exists on the target. If you set the field to Compare when there is no image on 
the target, Workbench will look for a file to compare and not find one, and the 
reset and download operation will fail.
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4.4.4  Instruction Pointer Tab

1. Select the Instruction Pointer tab.

2. Set the starting point for your file.

By default, the instruction pointer is set to use the starting address from the 
download file. 

You can set the instruction pointer to start the file from the first occurrence of 
a particular symbol (for example, main) or you can just specify a starting 
address by entering the address value in hex in the Use Specified Start 
Address field.

If you do not want to set a starting point, clear the Set Instruction Pointer 
After Download box.

4.4.5  Run Options Tab

1. Select the Run Options tab.
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2. Determine how you want your file to run.

By default, the Reset and Download view is set not to run the file after 
downloading. If you want the file to run, you have several options to 
determine where it should break:

■ You can set it to break at the first occurrence of a symbol (for example, 
main) by selecting Run to Symbol and entering the symbol in that field.

■ You can set it to break at the end of your program by selecting Run to end 
of program.

■ You can set it to break at a given memory address by selecting the Run to 
Address box and entering the address in hex in that field.

■ You can set it to break at an _exit routine by selecting the Break at Exit box.

If you need to perform a post-initialization, you can define it here. Select the 
Play post download script box and click Browse. In the browser window that 
appears, navigate to your initialization file.
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4.4.6  Source Tab

1. Select the Source tab.

2. Use the Source tab to configure the source path of your file.

Workbench uses the input path of the local file system by default. Unless you 
need to use a different path, you do not need to do anything in the Source tab.

If you need to use a different path, click Add... and use the Add Source dialog 
to configure the appropriate search path for your project.

4.4.7  Common Tab

1. Select the Common tab.
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2. Specify whether your launch configuration is local or shared.

The configuration is local by default. To make it shared, click Shared file: and 
browse to the shared directory where you want the configuration to be located.

You have now fully defined your reset and download operation.

4.4.8  Executing the Reset and Download

1. Click Debug.

This resets the target and downloads the specified file.

Workbench will first initialize the target board, then download the file, then 
run the file. 

The OCD Console view opens to show the progress of the reset and download 
operation.
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You can now step through instructions and debug code using the Resume and 
Suspend buttons in the Debug view. For information on debugging, see the Wind 
River Workbench User’s Guide.

4.5  Initializing Wind River ICE SX and the Target

If you make changes to the firmware of Wind River ICE SX, you must initialize it 
for the changes to take effect. Similarly, if you make changes to the target, you may 
have to initialize the target to have those changes take effect. 4.5.1 Initializing 
Wind River ICE SX, p.103, and 4.5.2 Initializing the Target, p.105, describe methods 
of initializing both ICE and the target, and provide some examples of situations 
where an initialization may be required. 

4.5.1  Initializing Wind River ICE SX

Any time you make changes to the ICE firmware, you need to initialize the unit so 
that the changes take effect. For example, after you configure ICE for network 



Wind River ICE SX for Wind River Workbench
Hardware Reference , 2.6.1  

104

operation, you must initialize it so that the unit recognizes its new configuration. 
You also need to initialize ICE any time the firmware is updated.

There are two methods of initializing Wind River ICE SX:

■ Power On, p.104

■ Reset, p.105

Power On

A power on is a complete power cycle of the ICE, and it occurs when the power 
switch on the back of the unit is turned from the OFF position to the ON position. 
In a power on boot up sequence, ICE searches for its component boards and runs 
a complete set of diagnostics for each board. Unless you have statically 
programmed an IP address into your ICE unit, the IP address for the unit is 
requested from the appropriate server during the cold start boot up sequence. Any 
other network information that is to be acquired dynamically is also set up during 
the initialization. The power on boot up sequence, as seen over a serial connection 
to ICE, resembles the following:

****************************************************************************
Wind River ICE Ethernet Platform
Copyright © Wind River Systems, Inc. 1999-2004.  All rights reserved
****************************************************************************
Firmware Type Wind River ICE BSP  Version 2.0a Created On: Oct 22 2004 
16:07:17

Configuring TCP/IP Network Suite:
   IP Address..... NVRAM = 255.255.255.255
   Netmask........ NVRAM = 0xFFFF0000
   Default Gateway None
   Routing........ Disabled
   MAC Address.... 00:A0:1E:00:3C:71

Supervisory command mode enabled..................... PASSED
Pseudo device initialization......................... PASSED
TFTP device initialized.............................. PASSED
Device inititalized.................................. PASSED
Starting TCP/IP on PORT A 10BaseT.................... PASSED
Starting TCP/IP on PORT B 100BaseT................... PASSED
Initializing FFS Driver.............................. PASSED
FFS disk initialized  26408 Kbytes free.............. PASSED
FFS disk 0 percent fragmented................... PASSED
Disk volume 45.0.0 initialization.................... PASSED
Starting TCP TGTCONS   server TGTCONS [ 1232] ....... PASSED
Setting TGTCONS baud rate to 9600.................... PASSED
Starting WRS shell server............................ PASSED
Wind River ICE System Shell - Type HELP for list of commands

>NET> 
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Reset

A reset occurs when the RESET switch on the back of the Wind River ICE SX unit 
is pressed. In this case, many of the tests that are run during a power on are run. 
However, ICE only runs a subset of its diagnostics. This means that the boot-up 
process is faster with a reset than it is with a power on. 

4.5.2  Initializing the Target

You need to initialize the target in order to obtain a connection when you first try 
to establish communications with it. Similarly, if the code you are running on your 
target causes the connection to be lost, then you also need to initialize the target in 
order to restore that connection. Initialization is also required if you change the 
register settings in the emulator and want them to be reflected in the target. 

The target is initialized whenever you first establish a connection using 
Wind River Workbench. If you need to initialize the target when you are 
debugging, you can do it using either the IN or the INN command. 

The IN and INN commands are terminal level target initialization commands, and 
they are the easiest way to initialize the target when you are working in the OCD 
Command Shell. The IN or INN command can be executed at a >BKM> or >ERR> 
prompt. If a >RUN> prompt is visible, stop the target running by typing a Ctrl + C 
key combination, a Ctrl + X key combination, or by typing HALT. The target stops 
running and a >BKM> prompt is visible. 

The IN and INN commands differ in that the IN command copies the register 
information that is stored in Wind River ICE SX’s non-volatile memory (NVRAM) 
to the target board after background mode is entered, whereas the INN command 
places the target in background mode without overwriting the target’s registers, 
leaving them in their default reset state for the processor. More information on 
register settings is available in the Wind River Workbench for On-Chip Debugging 
User Tutorials. The following two sections further describe the IN and the INN 
commands.

NOTE:  If you do not have an active serial connection to your Wind River ICE SX 
unit, you will not see this boot up sequence display in the Terminal view. The same 
set of commands and diagnostics are still run, regardless of whether or not you 
have this connection open.
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INN Command

The INN command is a low level command that is used to place the target 
processor into background mode. In order to get a processor into background 
mode, the reset line of the processor is asserted and then released. As a 
consequence of entering background mode, the processor and its peripherals on 
the target board are forced into their reset state (the same state as if you hit the 
Reset button on the ICE unit) and all of the internal registers are forced to their 
manufacturer’s reset value.

IN Command

The IN command does two different things. First, as with the INN command, it 
places the target board into background mode. Second, it copies all of the register 
information that is stored in ICE’s NVRAM for that target down to the target 
board.

Wind River ICE SX writes register values to the target for all of the register groups 
that are enabled at the time of initialization. Even if code is located on the target to 
properly configure the registers, ICE still overwrites the values when it first 
establishes communications (is initialized). For that reason, it is important to make 
sure that the register settings that are stored in the ICE unit’s NVRAM match any 
register configuration code on the target. The SCT DIFF command can be used to 
display the differences between the registers in ICE’s NVRAM and the registers on 
the target. More information on this command is available in the Wind River 
Workbench for On-Chip Debugging Command Reference, and more information on 
register configuration is available in the Wind River Workbench for On-Chip 
Debugging User Tutorials.

If you do not want ICE to configure the registers during initialization, use the INN 
command instead of the IN command. 

After initialization is completed, output appears in the OCD Command Shell:

>BKM>in
***************************************************************************
Wind River ICE Initialization Sequence.
Copyright (c) Wind River Systems, Inc. 1999-2005. All Rights Reserved.
***************************************************************************

Support Expires....... FlexLM key in use.
Target Processor...... MPC8260:U1

Wind River ICE Group ID#=0
Wind River ICE Serial #= MIKEFLEX Firmware= vn2.3a
Type CF For a Menu of Configuration Options
Initializing Background Mode....................Successful
>BKM>
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The information includes the version number of the hardware, the target 
processor, and the operation mode.

4.6  Troubleshooting Wind River ICE SX Communication 
Problems

If you have problems establishing communications with the target using 
Wind River ICE SX, it is likely that there is either a problem between ICE and the 
target, or between the ICE unit and the host computer. 

A good indication that the communication problem is between ICE and the target 
is if an >ERR> prompt displays in the OCD Command Shell after initialization 
instead of a >BKM> prompt. 

Problems between the ICE unit and the host computer are usually indicated by an 
error message. 

4.6.1  Problems Between Wind River ICE SX and the Target

Communication errors between ICE and the target are typically indicated by an 
>ERR> prompt in the OCD Command Shell. The following sections describe three 
solutions that you can try to correct this error. 

Register Files

If the target board you are using has been shipped with the registers uninitialized, 
you may have to download a register file (.reg) to the target (or specify one in your 
board file) before you are able to get the processor into background mode and see 
a > BKM > prompt in the OCD Command Shell. The Wind River Workbench for 
On-Chip Debugging User Tutorials provides step-by-step instructions for 
downloading a register file to your target. You can verify how the registers on your 
target board were shipped by referring to the documentation that came with that 
board. Often, your board includes a register file for the board that you just need to 
download. 
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Set Verbose On Command

The Set Verbose On command puts Wind River ICE SX into verbose mode, which 
can be useful when attempting to diagnose connection problems. Using the IN 
command at an >ERR> prompt only shows that the attempt to connect failed. 
Using verbose mode provides more information about where the communication 
attempt failed. 

To use verbose mode, follow the steps listed below.

1. At the >ERR> prompt in the OCD Command Shell, type set verbose on. 

2. Press ENTER, which returns you to an > ERR > prompt.

3. Type IN at the >ERR> prompt and press ENTER.

This time, the output in the OCD Command Shell lists all of the diagnostic tests 
that it performs while trying to place the target in background mode, and states 
whether the test passes or fails. The following shows an example of a JTAG target 
being initialized with verbose mode invoked:

>ERR>set verbose on
>ERR>in
****************************************************************************
Wind River ICE Initialization Sequence.
Copyright (c) Wind River Systems, Inc. 1999-2005.  All rights reserved.
****************************************************************************

Support Expires........ FlexLM key in use.
Target Processor....... MPC8260:U1

Wind River ICE  Group ID#=0
Wind River ICE  Serial#=MIKEFLEX  Firmware= vn2.2a
Type CF For a Menu of Configuration Options.

Testing Communications to Hardware Interface....Passed
Checking Paddle Board...........................Passed
Driving HRESET to be High.......................Passed
Driving HRESET to be Low........................Passed
Waiting HRESET Low Acknowledge..................Passed
Attempting JTAG Communication...................Passed
Waiting for HRESET to be Released...............Passed
Testing for target STOP State...................Passed
Comparing target CPU with CF setting............Passed
Waiting for HRESET High Acknowledge.............Failed
>ERR>

Using verbose mode helps you determine why the target cannot be placed in 
background mode. The entry for Set Verbose On in the Wind River Workbench for 
On-Chip Debugging Command Reference describes each of the diagnostic tests that 
are performed, and provides things that you can check to try to correct the 
problem. 
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Hardware

An >ERR> prompt in the OCD Command Shell can also signify a problem with 
the hardware connections between the ICE unit and the target. Check the 
following items to determine if the connection problem is hardware related. 

■ Make sure that all connections have been made between ICE and the target, as 
described in 2. Hardware Setup.

■ Make sure that power has successfully been applied to both ICE and the target.

■ Make sure that all connections are tight.

■ If you are using the OCD extender cable or a right angle connector to connect 
ICE to the target, try making a direct connection instead if possible. That 
eliminates any noise that may be interfering with the connection attempt.

4.6.2  Problems Between Wind River ICE SX and the Host

If no prompt is visible in the OCD Command Shell, or if an error message is 
shown, it is likely that the connection error is between the Wind River ICE SX and 
the host computer. Communication problems of this nature are usually related to 
the physical connections between the ICE and the host. The following two sections 
describe some of the common problems and solutions for these types of errors.

Hardware

Error messages of this type can signify a problem with the hardware connections 
between the ICE unit and the host computer. Check the following items to 
determine if the connection problem is hardware related. 

■ Make sure that all connections have been made correctly and are tight, as 
described in 2. Hardware Setup. Pay extra attention to the connections between 
ICE and the host. 

■ Make sure that power has been applied correctly to the ICE unit.

Networking

The problem may also occur because your ICE unit is not being recognized on your 
network. Make sure that you have set up your ICE unit correctly for network 
operation, as described in 3. Configuring Wind River ICE SX for Network Operation. 
Try pinging your unit, as described in Testing the Installation, p.67 of 3. Configuring 
Wind River ICE SX for Network Operation to make sure that your ICE is being 
recognized on the network. 
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4.6.3  License Key Problems

If the error message shown in Figure 4-1 appears when you try to connect, your 
emulator’s license key is incorrect or expired. 

To upgrade your license key, use the following steps:

1. Right-click in the Target Manager and select OCD Utilities > Capture Current 
Key to File.

A browser window appears.

2. In the browser’s Look In field, select Desktop.

3. In the browser’s File Name field, enter your name and append .txt.

For example, if your name were John Smith, you would name the file 
JohnSmith.txt.

4. Click Open. 

Workbench automatically creates the text file and logs your current license key 
to it.

5. Send an email to licadmin@windriver.com and attach the text file you created 
in the preceding steps.

This file contains the license key that Wind River needs in order to upgrade 
your Wind River ICE SX.

When you request a new license key, your email must include the sales order 
number associated with the upgrade. Within 24 hours you will receive a message 
with a text file attachment that contains your upgraded license key.

To install your new license key, use the following steps:

1. Open the email message you received from Wind River and save the attached 
file to your desktop.

Figure 4-1 License Key Error Message
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2. Connect your Wind River ICE SX to your host PC and open Wind River 
Workbench. 

3. Right-click in the Target Manager and select OCD Utilities > Install License 
Key From File.

A browser window appears. 

4. Navigate to the file you saved on your desktop in Step 1 and Click Open.

This will burn your new license key.

4.7  Working with Wind River ICE SX 

Once you are in background mode and have a >BKM> prompt visible in the OCD 
Command Shell, you are ready to verify that your ICE and target are working 
together correctly, and you can begin working with your system. 

This section provides a brief description of some of the tasks that you can perform 
with your ICE unit. Detailed instructions and descriptions for performing most of 
the tasks using the Wind River Workbench GUI are provided in the Wind River 
Workbench User’s Guide. In addition, a complete command reference of the low 
level Wind River ICE SX command language is laid out in the Wind River 
Workbench for On-Chip Debugging Command Reference. Any commands described in 
that document can be entered at the >BKM> prompt in the OCD Command Shell 
with the correct syntax.

Configuration Options

To see the configuration options available for your target, click on Window in the 
toolbar. From the drop-down list that appears, 
choose Show View > CF Options View.

Alternatively, your target can be configured using the low-level CF command, 
which can be issued at either a >BKM> prompt or an >ERR> prompt in the OCD 
Command Shell. Although the configuration options for a target vary depending 
on the target you are using, typing the command CF at a prompt provides a list of 
the options that are available for your target. Please note that these options are 
subject to change with new revisions of the product.



Wind River ICE SX for Wind River Workbench
Hardware Reference , 2.6.1  

112

Figure 4-2 shows an example of the configuration options that are available for a 
PPC750FX target.

To make a change to any of these values, double-click on its entry under the 
Current Setting heading to bring up a list of parameters. Select the parameter you 
want and click the Send All CF Options to Target icon. For most options your 
changes will not take effect until you issue a reset using the IN or RST commands.

To change CF options using low-level commands, type CF and the CF option to be 
modified, followed by the specific parameter to be configured (all on the same 
command line) at the >BKM> or >ERR> prompt in the OCD Command Shell. 

NOTE:  The CF command can be entered at either the >BKM> prompt or the >ERR> 
prompt, but not at a >RUN> prompt. 

Figure 4-2 PPC750FX CF Options

NOTE:  The CF options listed will not be the same for all targets. This is a PPC750FX 
example only.
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For example, to configure the system for an MPC8240 target rather than the 
PPC750FX displayed above, you would type:

>BKM>CF TAR 8240

If you type CF again and press ENTER, 8240 would display next to the Target CPU 
parameter in the list of configuration options. 

A full listing of the available configuration options and descriptions is available in 
the Wind River Workbench On-Chip Debugging Configuration Options Reference. 
Please refer to this document for more information about configuration options. 

Boot Register Initialization

Once communications are established with Wind River ICE SX and the target, the 
registers required for initialization must be programmed and configured, a 
necessary step prior to downloading code. In order to be able to access a peripheral 
device using the OCD link on your target, it is necessary for all applicable registers 
in the interface to be properly configured.

Detailed information about working with registers is included in the Wind River 
Workbench for On-Chip Debugging user Tutorials: Configuring Target Registers. Please 
refer to that document for more information about how to program and configure 
the registers required for initialization. 

Setting Chip-Selects with the CS Command

The CS command provides information about a special set of registers that are 
used for controlling the chip selects within a target. Not all targets possess 
programmable chip-selects. Refer to your processor documentation for 
information about chip-selects on your target.

If your target does include programmable chip-selects, the CS command allows 
you to view a table that lists the available chip-selects with all of their options. Each 
of the entries in the table can be programmed as described below.

NOTE:  If your target has valid running boot initialization code, you may omit the 
register initialization process and rely on your own boot code to initialize your 
board. To reset your target, start your boot code, and stop the target, you may use 
an INN; GO; HALT command sequence in the OCD Command Shell. 
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Type CS at the >BKM> prompt with no parameters to display the chip-select table 
for your target, as shown in Figure 4-3.

To modify any of the chip-selects, type the CS command followed by the name of 
the chip-select you want to modify. For example, to modify chip-select cs0, you 
would enter

>BKM>CS CS0

The options and the current settings for that chip-select display one line at a time, 
allowing you to make individual changes to the settings. To move from one line to 
the next, press ENTER. An example for setting chip-select cs0 is shown below.

>BKM>cs cs0

(0-6) = GP6,GPL SD6,SDL,UPMA,UPMB,UPMC | Machine State = GP6 >
0000000 -> FFFF8000 | Base Register = FE000000 >
0000000 -> FFFF8000 | Address Mask = FE000000 >
0 = Not Valid, 1 = Valid | Valid State = Valid >
(0-3) = 64, 8, 16, 32 bits | Port Size = 8 Bits >
(0-3) = OFF, Normal, RMW, Correct & Check | Data ECC = Disabled >
0 = Read/Write, 1 = Read Only | Write Product = Normal >
0 = Disabled, 1 = Enabled | Ext MEMC Enable  = Disabled >
(0-3) = Normal,RAWA,WARA,Rsvd | Atomic Operation  = Normal >
0 = Normal, 1 = Delayed | Delayed Read  = Normal >
0 = Normal, 1 = Early | CS Negation  = Early >
(0-3) = Normal, rsvd, 1/4 clk, 1/2 clk | Address/CS Setup  = Normal >
0 -> F (Number of Wait States) | Wait State(s)  = 5 >
0 = Internal, 1 = External | Trans Ack (SETA)  = Internal >
0 = Normal, 1 = Relaxed | Timing Relaxed  = Relaxed >

Figure 4-3 Chip Select Table
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0 = Normal, 1 = Extended | Extend Hold Time  = Extended >

>BKM>

The chip-select table is stored in the ICE NVRAM, and is automatically 
downloaded to the appropriate target location after every initialization sequence 
using the IN command. If you want to initialize the system without writing the 
chip-select table, use the INN command, or disable the chip-select group using the 
CF GRP command, as described in the Wind River Workbench for On-Chip Debugging 
Command Reference. 

Any time you change the chip-select table, you must issue an IN command to 
download your new table to the target for the changes to take effect. 

4.8  Moving On

For information on using your Wind River ICE SX to download, run and debug 
application files in Wind River Workbench, please see the Wind River Workbench for 
On-Chip Debugging User Tutorials. 
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   5
Using the Firmware Update

Utility

Use the Firmware Update Utility in Wind River Workbench to update the 
firmware on your Wind River ICE SX.

Figure 5-1 Firmware Update Utility

NOTE:  You can only update firmware in the Wind River ICE SX when you do not 
have an active debugging session attached to it. 
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To use the Firmware Update Utility:

1. Open Wind River Workbench.

2. If you have not already established communications with your 
Wind River ICE SX, do so now using the procedure described in 4. Establishing 
Communications.

3. Right-click on the processor under your target name in the Target Manager 
view and select OCD Utilities > Firmware Download..., as shown in 
Figure 5-2.

The Firmware Update Utility appears, as shown in Figure 5-1.

If an error message such as the one shown in Figure 5-3 appears, you must 
disconnect the Wind River ICE SX from any active debug context.

Setting the Firmware File Directory

Wind River Workbench automatically searches for the directory named firmware, 
located in installDir/workbench-2.x/dfw/version/host/firmware, where version is 
the installed version of the debugger middleware. 

Figure 5-2 Firmware Download Option

Figure 5-3 Firmware Update Warning
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To change the default firmware directory:

1. Click Browse. 

2. In the browser window that appears, navigate to your desired directory and 
click OK. 

This will populate the Firmware File Name field with the .bin files from your 
directory. 

Click on any .bin file to highlight it. Its components appear in the Component field 
below, with their release version numbers appearing under the Version field. The 
file’s creation date appears in the Description field to the right.

Downloading Firmware to the Wind River ICE SX

Click Download to download the highlighted firmware to your 
Wind River ICE SX.

Downloading new firmware can sometimes reset the emulator’s configuration and 
register settings. To save your settings in order to restore them after the download, 
check the Save Config and Register Settings to a File before Download box.

If you check this box, a browser window will appear when you click Download. 
Use this window to choose a folder to save your settings in. They will be saved as 
a .reg file. After the download, right-click in the Registers view and select Play 
Register File to restore the settings.

If an error message appears when you click Download, your flash file system may 
be full. Check to make sure you have flash memory available for the firmware 
download.

To cancel to firmware update, click Abort.

Refreshing the Firmware File List

If you make changes to your firmware directory while the view is open, you can 
click Refresh to refresh the list in the Firmware File Name field.
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